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1. Introduction
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2. User Manual 

This chapter describes the user manual of WAIKATO SDSS, a decision support system build 
with the GEONAMICA® SDSS application framework. The WAIKATO SDSS is developed for 
the Waikato region to support Environment Waikato’s Long-term Council Community Planning 
Process. 

This manual contains five sections: 

Section 2.1 “Getting started” explains how to install WAIKATO SDSS on your computer and 
how to start the program. It also describes the main features of the graphical user interface. 

Section 2.2 “Running simulations” contains a step-by-step description of how to run a 
simulation in WAIKATO SDSS. 

Section 2.3 “Policy interface” describes the steps of how a policy user carries out an integrated 
impact assessment with the WAIKATO SDSS system. 

Section 2.4 “Modeller interface” describes the interface for the modeller to access the 
underlying models and to update data and parameter settings through the system diagram in 
WAIKATO SDSS. 

Section 2.5 “The WAIKATO SDSS menu system” offers a systematic description of each option 
in the menu system. 

2.1 Getting started 
This chapter explains how to install WAIKATO SDSS on your computer and how to start the 
program. It also describes the main features of the graphical user interface. 

2.1.1 Installing WAIKATO SDSS: Hard- and software requirements 

WAIKATO SDSS runs on personal computers equipped with modern Intel or Intel compatible 
processors. To use WAIKATO SDSS, your computer should have the following hardware 
components: 

• At least 1GB of RAM 
• A hard disk with at least 10GB free  

To make full use of the application, you should have the following software packages installed 
on your computer: 

• Microsoft® Excel (version 97 or later) (optional) 

The WAIKATO SDSS is developed for Windows XP. If you experience problems by installing 
the  WAIKATO SDSS on Windows vista, please can contact us (see section 2.1.9). 
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2.1.2 Installing WAIKATO SDSS: Installation procedure 

The following is a step-by-step description of the installation of WAIKATO SDSS. The 
installation/uninstallation of WAIKATO SDSS follows the standards for Windows. 

If you have a previous version of the WAIKATO SDSS software installed on your machine, you 
will be asked whether you want to uninstall it first. It is better to uninstall it. If you would want 
to keep it, make sure to put (this new version of) WAIKATO SDSS in a separate directory. 
During the installation you may encounter a message asking whether you want to keep or 
replace certain files. It is preferred to replace them for use with WAIKATO SDSS. Keeping the 
old files may cause malfunctioning of the software. 

To Install WAIKATO SDSS: 

1. Start Microsoft Windows XP. 
2. Insert the WAIKATO SDSS CD-Rom into the drive. 
3. Click the Start button in the Windows XP Task bar. Move the mouse pointer to the 

Settings command and select the Control Panel option. As a result the Control Panel 
window will open. Select Add or Remove Programs icon by double clicking it. Next 
click the Add New Programs and the CD or Floppy buttons in the Add or Remove 
Programs dialog window. 

4. Next, the installation program will be started and will request you to click the Next 
button until (1) the program has selected your CD-drive as the installation medium, and 
(2) until it will have found the Waikato SDSS_1.0.0_setup.exe program for WAIKATO 
SDSS on the CD-Rom. If the installation program does not find the CD-drive or the 
Setup.exe, then press the Browse button, navigate to the right drive, and find the 
Waikato SDSS_1.0.0_setup.exe on the WAIKATO SDSS CD-Rom. The command line 
‘(drive): Waikato SDSS_1.0.0_setup.exe’ will appear in the edit field of the Run 
Installation Program dialog window. Press Finish to continue the installation. 

5. The wizard is started. A dialog window is opened asking you where to install 
WAIKATO SDSS. You may accept the default path, which is ‘C:\Program 
Files\Geonamica’ or press the Browse button and define an alternative location. 

6. To go on, press the Next button. Otherwise to cancel the installation process, press the 
Cancel button. 

7. Next the installation program suggests adding WAIKATO SDSS to the new Program 
Group GEONAMICA®. You are free to create another Group or to choose an existing 
one from the list shown. 

8. Next the installation program will ask you to choose the features of WAIKATO SDSS 
you want to install. Select the Waikato SDSS option and Data option. 

9. From that moment the installation application is decompressing the necessary files and 
puts them in the directory structure of WAIKATO SDSS. 

10. Once the installation on the hard disk is completed, the program creates a group named 
Geonamica under the Start button and Programs command. It contains an item labelled 
Geonamica. When you double click this item, WAIKATO SDSS will be started and the 
About window will open. Click the OK button to open the Open dialog window. 

11. Follow the procedure outlined in the steps 1 to 9 to install the MAP COMPARISON KIT 
and OVERLAY-TOOL. The files relative to the former are stored in the directory Map 
Comparison Kit and the files for the latter are stored in the directory Overlay Tool on 
the WAIKATO SDSS CD-Rom. 

12. You can start to use the WAIKATO SDSS when the installation is finished (see section 
2.1.5). 

To Uninstall WAIKATO SDSS: 
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1. Click the Start button in the Windows XP Task bar. Move the mouse pointer to the 
Settings command and select the Control Panel option. As a result the Control Panel 
window will open. Select Add or Remove Programs icon by double clicking it. Next 
click the Change or Remove Programs button in the Add or Remove Programs 
Properties dialog window. 

2. Next select WAIKATO SDSS from the list of applications that can be automatically 
removed by Windows and press the Change/Remove button. 

3. The Confirm File Deletion dialog window will open. Press the OK button to confirm that 
you want to remove WAIKATO SDSS and all its files from your hard disk. 

4. Repeat the steps 1 to 3 to uninstall the MAP COMPARISON KIT and OVERLAY-TOOL. 

2.1.3 WAIKATO SDSS directory structure 

When the above described installation of WAIKATO SDSS is completed, the files that are part of 
WAIKATO SDSS, GEONAMICA® and the WAIKATO SDSS case(s) distributed with the 
installation CD-Rom are ordered in a typical directory structure.  

  
WAIKATO SDSS is typically installed in the directory C:\Program Files\Geonamica. Three sub-
directories are created: Waikato SDSS, Map Comparison Kit and Overlay Tool. The Waikato 
SDSS directory contains Geonamica.exe and all the DLL-files required running the WAIKATO 
SDSS application (see figure below).  
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The other parts of WAIKATO SDSS are the data, simulation files and the intermediate output 
maps. These are located in my documents\Geonamica\Waikato SDSS\Simulations. In here you 
will find among others several simulation files, recognizable by the extension *.xml. These files 
contain the basic information the software needs to run a simulation. Additionally, the 
simulations folder contains all the data that is used in the simulation. The simulations folder 
typically contains the following sub-directories and files: 

 
• Animations, containing the animation maps relative to the simulations; 
• InputMaps, containing the base maps relative to the simulations  
• IntermediateMaps, containing the intermediate output maps for the current simulated 

year; 
• Legends, containing the legends of the maps relative to the simulations; 
• Log, containing the log files relative to the simulations; 
• Land use and Economics.xml, the simulation file for the prototype version of WAIKATO 

SDSS, specifically including the land use model and the economic model. 
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2.1.4 MAP COMPARISON KIT directory structure 

MAP COMPARISON KIT is typically installed in the directory C:\Program Files\Geonamica.The 
directory Map Comparison Kit contains the MAP COMPARISON KIT application (MCK.exe) and 
a set of DLL-files (RasterComparisonModule.dll, GeonamicaLib.dll, xerces-c_2_6.dll, 
mfc71.dll, msvcp71.dll, msvcr71.dll) required by the application.  

 
Further to this, the other parts of MAP COMPARISON KIT are located in my 
documents\Geonamica\MCK. There are four sub-directories in this folder: 

• Examples, containing examples developed for the MAP COMPARISON KIT; 
• Palettes, containing the map legends for the MAP COMPARISON KIT; 
• Results, containing results generated with the MAP COMPARISON KIT; 
• Temp, containing the temporary outputs (e.g. reference maps) generated with the MAP 

COMPARISON KIT 

 

2.1.5 Starting WAIKATO SDSS 

Once it is installed, you can start the WAIKATO SDSS application as follows: 

 
• Under the Windows Start button and the All Programs group, you will find a group 

called WAIKATO SDSS. Click on the GEONAMICA® icon. 



 

 10 

  
• WAIKATO SDSS will be started and you will see the GEONAMICA® application 

window on your screen. 

 
• A message window appears requiring the license file when you start to use the 

WAIKATO SDSS for the first time. Click the OK button on the message window. 

 
• A dialog window opens where you can look for the license file for WAIKATO SDSS 

that you received from RIKS. Select the license file and press the Open button of this 
dialog window.  

• The licence files will be created automatically in the same directory as Geonamica.exe. 
After this action, the system will not ask you to open the licence file when you restart to 
use the WAIKATO SDSS. 

 
• Now you can start to use the WAIKATO SDSS. 
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2.1.6 Screen Layout 

 
When you start WAIKATO SDSS, you will enter immediately in the application window of the 
simulation environment. This is the window in which you will run your models. You can 
arrange windows as you like in the application window. Before a simulation file has been 
opened, the window is empty except for its Caption bar, Status bar, Toolbar and Menu bar. The 
different components of this window will be described in the next paragraphs. 

The Caption bar 

The Caption bar, also called title bar, of the application window shows the name of the 
application: GEONAMICA®. As soon as a simulation file is opened, the title will be extended 
with the name of the simulation file.  

 
• To the right of the Caption bar three buttons are positioned that enable you to resize the 

GEONAMICA® application window: 
• The Minimize button to the left allows you to shrink the window to an icon. This is the 

same as pressing Minimize in the Control menu box. 
• The Maximize button in the middle allows you to enlarge the application window to the 

full size of the screen. This is the same as pressing Maximize in the Control menu box. 
• The Close button to the right allows you to close the application window, and thus quit 

the application. This is the same as pressing Close in the Control menu box. 

The Menu bar 

The Menu bar of the application window contains WAIKATO SDSS’s main menu. The 
commands are logically organised in the menu so that you will quickly become comfortable 
with the various functions of the program. The menus are summarised in the table below; 
subsequent sections elaborate on the description. Section 2.5 gives an overview of all menu 
commands. 

Use this menu To … 
File Manage your simulation files.  

Status bar Application Window Status bar 

Toolbar

Application Window 

Menu bar Caption bar 
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Simulation Control the simulation.  
Options Customise the workspace. Commands permit among others to 

display or remove the Status bar and/or Toolbar, and select types 
of output 

Window Manage your windows on the screen  
Help not implemented 

The Toolbar 

The Toolbar gives faster access to some of the more frequently used commands that are also 
accessible via the menu.  

 
Use this Button To … 

 Open a simulation file from the disk. 

 Save a simulation file to disk. 

 Advance the simulation with one simulation step. 

 Advance the simulation till the next pause is reached. 

 Stop the simulation after the current step is finished 

 
Reset the simulation. Switch the simulation clock back to the 
initial year of simulation. 

Besides this set of buttons, the Toolbar also displays the simulation clock. Each time step, the 
clock is updated to match the current value, which means that it will be incremented by a value 
of 1 year. 

 
The Toolbar command in the Options menu gives the option to display or hide the Toolbar in the 
GEONAMICA® application window. 

The Status bar 

The Status bar is displayed at the bottom of the application window. This zone provides 
information to the user on his actions while he is working with the application. The left area of 
the Status bar describes actions of menu commands as you use the mouse or arrow keys to 
navigate through menus. Also messages are shown describing the actions of Toolbar buttons 
when pressed. The right area of the Status bar indicates which of the following keys are latched 
down: the Caps Lock key (CAP), the Num Lock key (NUM), or the Scroll Lock key (SCRL). 

The Status bar command from the View menu gives the option to display or hide the Status bar 
in the GEONAMICA® application window. 

2.1.7 System information 

The different commands in the Help menu will permit to look up the system information about 
WAIKATO SDSS, its commands, options, and tools. Use the Help menu to select the type of 
information that you want WAIKATO SDSS to display on the screen. 
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Index 

Use the Index command to get the opening screen of the on-line help file of WAIKATO SDSS. 
From the opening screen, you can jump to step-by-step instructions for using WAIKATO SDSS. 
Double click the topic that you want help on. Once you open help, you can click the Contents 
button whenever you want to return to the opening screen. 

Using Help 

Use the Using Help command for getting general instructions on how to use the Windows Help 
System.  

Licence 

Use the Licence… command for getting the licence information on the Licence window.  

The system allows the user to import the licence file that you received from RIKS by pressing 
the link of Read a licence file… to open the Open dialog window.   

 

About 

Use the About… command to open the About window. You will find here the copyright notice 
and version number of the GEONAMICA® application that you are using. The latter is important 
if you need assistance with the software from the developers (see section 0) or when you request 
an update of the software. 



 

 14 

 
 

Version number 
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2.1.8 Closing WAIKATO SDSS 

Closing WAIKATO SDSS is done by selecting the Exit command from the File menu. If you 
have simulation files open and you have made any changes, the application will ask whether 
you want to save simulation results before exiting.  

 
If you confirm that you want to save changes, you will get the Set external file names dialog 
window. Press the Yes button of the Save dialog window to carry out the action of saving and 
exiting. More information on saving simulation results is given in section 2.2.4 of this manual. 

2.1.9 If you experience problems 

If you experience problems installing or running WAIKATO SDSS, please contact us with the 
version number of the GEONAMICA® application that you are using (see section 2.5.5 Help 
menu): 

Research Institute for Knowledge Systems bv. 

To the attention of Hedwig van Delden 

P.O. Box 463, 6200 AL Maastricht, The Netherlands 

Tel: +31 (43) 3501750 

Fax: +31 (43) 3501751 

E-mail: info@riks.nl 

Website: www.riks.nl 

2.2 Running simulations 
This section describes how to run simulations with WAIKATO SDSS. It deals primarily with the 
interaction between the user and the software. Only a global overview of the model itself will be 
given. For details about the model, we refer to the accompanying reports of WAIKATO SDSS. 

In the previous section we explained how to install and run WAIKATO SDSS. We assume from 
now on that you have read this information, that you have knowledge of the different technical 
terms introduced, and that you have successfully installed WAIKATO SDSS on your computer. 

2.2.1 Opening a simulation 

Opening a simulation file 

Make sure that you have started the WAIKATO SDSS (see section 2.1.5 Starting WAIKATO 
SDSS) and the GEONAMICA® application window appears on your screen. 

 
The Open dialog window will open. If the Open dialog window is not on your screen, press the 
Open simulation file button in the Toolbar. 
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Look in the Open dialog window for files with a .xml extension which are installed under my 
documents\Geonamica\Waikato SDSS\Simulations. 

 
Navigate through the directories on your hard disk or on another computer in the network, in 
search of the simulation file of your choice. Once the name of the file appears in the Open 
dialog window, select it and press the Open button or double click the file icon. 

The .xml file contains references to all the files that are required to run a model.  

Once all files have been loaded, two windows will appear in the application window: one titled 
the Main window and the Land use map. It is not possible to close these windows. You can 
move them and change their size to organise your workspace, including Minimizing or 
Maximizing. 

The main window 

The Main window is divided into two parts: the Navigation pane on the left hand side of the 
Main window and the Content pane on the right hand side of the Main window. The Navigation 
pane consists of 4 Tabs: Drivers, Scenarios, Indicators and Analysis. If one of the Tabs is 
clicked, the list of Elements under this tab appears. When clicking on one of these Elements, the 
underlying contents will be displayed on in the Content pane on the right side of the Main 
window. You can expand one of the tabs by clicking on this tab and you can close this tab by 
clicking another tab. 
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The Main window provides access to the policy user and the modeller. Section 2.3 and section 
2.4 provide detailed descriptions of interface for these two types of users. 

2.2.2 Editing Input and Displaying output 

In WAIKATO SDSS system, the inputs and outputs are organised by map, map file, graph, 
single value and table. The following sub sections describe how to edit input and display output 
by the categories of map, map file, graph, single value and table.  

Map window 

A Map window is split into 5 viewing areas, called panes. Panes are separated from one another 
by means of Splitter bars. The Land use map window is a Map window. We use the Land use 
map window as one example of Map window. 

You can freely open and close maps, except for the Land use map window. Beware: opened 
windows are updated while the simulation is running and this consumes processing time, hence 
the program will be slowed down. 

You can displace the splitter bars to change the size of the panes. To this end, position the 
cursor over the splitter bar. Move the mouse with the left mouse button held down to move the 
splitter bar and change the size of the panes accordingly. 

Navigation pane 

Content pane 

Splitter Bar 

Tab 

Section 
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Splitter bar 

Panes are separated from one another by means of Splitter bars vertically or horizontally. If 
contents of the pane are not displayed completely, use the scroll bars to move vertically or 
horizontally. 

Map pane 

The pane in the middle of the Land use map window – called the Map pane – contains a map 
representation of the modelled region. More in particular, the actual land use map is shown. The 
Map pane is equipped with a vertical scroll bar and a horizontal scroll bar. 

In the Land use map information is presented per cell. The cells on the map represent the 
predominant land use on a cell. To the left of the land use map you can find a legend that 
explains the meaning of the colours on the map. When the simulation is running, the Land use 
map window will be updated and the resulting land-use will be displayed in the Map pane. 

Legend pane 

The legend of the map is displayed in the upper left pane called Legend pane. It shows the 
legend of the selected map in the Layer Manager on the right top of the Map window (see 
section Layer Manager). For example, if you select land use map, the legend pane shows the 
legend of land uses. 

Legend pane 

Map pane Overview pane 

Splitter bar 

Layer Manager 

Tool pane 

Layer visibility 
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The land use is classified by 3 states (see section Land use classes): Vacant, Function, Feature. 
In the Legend of the map, the Vacant states appear at the top of the list, the Function states are 
underlined, and the Feature states appear at the bottom of the list. 

Overview pane 

The lower left pane of the Land use map window, called the Overview pane, shows the whole 
modelled region. The inverted rectangle shown in this small map localizes the region that is 
currently displayed in the Map pane. If the mouse is placed inside this wire-frame, it can be 
moved by holding the left mouse button clicked down. While the rectangle is moved, you will 
notice that the overview of the map in the Map pane is changing accordingly. The overview of 
the map can also be changed by means of the scroll-bars of the Map pane.  

Layer Manager 

The upper right pane of the Land use map window called Layer Manager shows the layer view 
of maps: Land use map and District boundaries. The Land use map is a grid layer. You can click 
the Layer visibility button to turn layer visibility on or off. 

Use this button  To: 

 Turn on the layer visibility 

 Turn off the layer visibility 

Tool pane 

The lower right pane of the Land use map window (called Tool pane) shows the tools for 
viewing and editing selected layers. The Tool pane includes the Zoom tools, Grid tools, and 
Network tools. You can open the Context menu of the Tool pane by right click, which controls 
how tools are arranged on the desktop. The list below summarized the Context menu 
commands. 
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Use this button  To: 
Expand all  Expand all the tools in map window 
Collapse all Close all the tools in map window 
Zoom tools Change the manner in which different maps of map window are displayed 
Grid tools Edit, check and save grid map 
Network tools Edit and display network map 

Zoom tools 

When you would like to see a location in more detail you can use the layer manager on the right 
hand side of this window. In the layer manager you will find the option zoom operations under 
which you will find the selected buttons: 

Use this button  To: 

 Zoom in. 

 Zoom out. 

 Pan on the map to view another location. 

 Select a region of the map to zoom in on. 

 Fit the entire map in the window. 

When you activate one of these buttons and move the mouse pointer to the map, you can carry 
out the selected option. 

Grid tools 

You can use Grid tools to edit and view the information of the maps that you selected. 

Use this Button To … 

 
Change the pointer to a pen. The pen is used to pick a value from the 
legend and enter it in a cell on the map. 

 
Change the pointer to a bucket. The bucket is used to pick a value from 
the legend and enter it in larger, contiguous areas of the map. 

 Display the information of the selected map on the map windows 

 
Copy the shape and color information in the selected area from another 
grid layer to the current grid layer 

 
Copy the color information on the selected area from another grid layer 
to the current grid layer 

 Save map that you select 

Network tools 

You can use the Network tools to view and edit the Infrastructure network. In this version of 
WAIKATO SDSS, about how to access the Infrastructure network map, the user can refer section 
How to view and adapt the road network? 
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When the Network map is active, the Network tools section of the Tool Pane on the right bottom 
part become active. The network map displays in the Map pane. The Legend pane consists of 4 
legend tabs which are used for editing the legend of Network map. 

The Network map is organized by links and nodes in the Map pane. Each link in the network 
map has a range of properties. 

• Click the Select/edit button, then move the mouse over the interested link, double left 
click on it or right click on it and select the option Properties. The link is selected and 
displayed in red. The Properties window pops up, in which, all the properties of this 
link are shown in the table of the Properties window.  

• It enables to change the network as links and nodes can be added or removed 
interactively. In this version WAIKATO SDSS, the Add link and Add nodes buttons are 
not available and are therefore greyed-out. In the future version WAIKATO SDSS, the 
user will be able to change the characteristics of links. 

• Click on the dropdown list of the Color master field to select the property of link 
Acctype, whose categories will be used as the Link color legend of the network displayed 
in the Map pane: Motorway, Dual carriageway road, Other road and Car ferry. All the 
properties of link are displayed on the dropdown list the Color master field, but only the 
Acctype categories are used as color legend. The user can determine or edit the Link 
color legend by double clicking on the category list. Section Legend editor describes 
how to use the legend editor.  

• Select the check box Show nodes to display the nodes of a network in the Map pane. 
• Select the check box Show links to display the links of a network in the Map pane. 

Customizing map output 

Each land use map, potential map, neighbourhood effect map and accessibility map in 
WAIKATO SDSS is presented with its dedicated legend. These legends are completely 
customizable. The legends may contain the colour information for the different classes or they 
may apply colours from a palette file. That is why this section contains a section about the 
LEGEND EDITOR and a section about the PALETTE EDITOR. For typical users it suffices to only 
use the LEGEND EDITOR. 

Legend 
Layer 
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Legend editor 

Double clicking on the legend opens the Legend Editor dialog window. In the figure below, the 
window is shown and the relevant settings are briefly explained. 

 
The Legend editor dialog window is divided into several areas which contain the information 
relative to different aspects of the legend: 

• On the left, the legend is shown as it will appear in the Legend pane of the map 
window. If one of the classes is double clicked, one can manually adjust the colour of 
the class and / or its label (for categorical legends) or its range (for numerical legends) 
in the Class characteristics dialog window (see below). 

• At the top right are the usual OK and Cancel buttons. 
• At the bottom right is an Apply button. When clicked it updates the legend on the left 

side of the window. Note that the legend of the map will only be updated if OK is 
pressed and will stay unchanged if Cancel is pressed. 

• In the top centre of the legend editor is the Palette settings section, which controls the 
palette settings. One of the predefined palettes can be selected from the list box. The 
order of the colours in the palette can be reversed by clicking one of the radio buttons in 
the section named Top of legend is. Finally, one can modify the palette by clicking on 
the Edit… button, which will open the palette editor, as discussed in paragraph 0. 

• In the Legend type section one can select the legend type and enter the number of 
classes. If the number of classes is changed the Apply button needs to be clicked for the 
changes to take effect. Only the number of classes and the colour of each class will be 
changed according to the palette, not the class ranges or labels. 

• The items in the Numerical legend settings section are only available if the legend type 
is numerical. If so, the labels of the classes will typically be set automatically by the 
legend editor. However, you can change the format of the labels in the Labels section. 
You can set both the number of decimals and the label format of all classes. If you set 
the latter to Custom, you can change the labels of each class manually by double 
clicking on that class in the legend on the left of the window. 

Click box to 
modify the 
class charac-
teristics 

Select type to 
fit data in map 

Set legend range 

Select scaling method 

Select the scaling 
method that fits the 
data best 

Set label accuracy 

Choose the appearance of 
legend labels Apply latest settings 

Choose the order 
of legend entries 

Set number 
of classes 

Open Palette 
editor 

Choose the order 
of legend colours 

Select palette 
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A legend is a classification of values in a map and a mapping of those classes to several other 
characteristics, such as labels, ranges or colours. Basically, there are two distinct types of 
legends, namely categorical and numerical legends. Categorical legends divide the possible 
values in a map into categories that have a name and a colour. An example of a map with a 
categorical legend is the land use map in the Land use map window, although you cannot use 
the legend editor on this map directly. Numerical legends make a partition of a range of values 
into smaller ranges – the classes – and allocate a colour to each class. Numerical legends are 
often useful for indicator maps. 

When we make such a partition for a numerical legend, the goal is to make a partition that 
follows the distribution of the values in the map, but also distinguishes extreme values from 
other values and makes full use of all classes in the partition. Since this is not a trivial task, the 
legend editor provides some automation in creating a numerical legend. 

As a first step, one can specify the total range of the legend in the Display interval section or 
choose for an automatic range that will be set to the range of values in the map. The second step 
is to select a scaling method to set the class boundaries. The list box in the Scale section allows 
you to select one of the available scaling methods. When a method is selected, the class ranges 
will be calculated and presented in the legend on the left of the dialog. The legend editor also 
calculates an estimate of the effectiveness of the chosen scale that can range from 0 to 100%, 
where more is better. If the Find best scale button is clicked, the legend editor will iterate over 
all available scaling methods and select the one with the highest estimated effectiveness. 

A description (see section 2.6 Appendix)is given of the different scaling methods and the way in 
which the estimated effectiveness is calculated. 

Class characteristics dialog 

 
When you click in a colour box in a legend, the Class characteristics dialog window opens, 
enabling you to define the characteristics of a class including the colour to represent the cells 
that belong to the class. If the legend is categorical, you can also change the label, but not the 
lower- and upper bounds of the class. If the legend is numerical, you can change the lower- and 
upper bound of the class and the label, if label format is set to Custom in the legend editor. 
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Palette editor 

 
The PALETTE EDITOR allows you to modify a palette manually or semi-automatically. By 
double clicking on one of the categories on the left side of the window, you can select a colour 
for that category. Palettes are stored either as palette-files (*.smp) or as a custom palette in the 
legend. You can create, open and save palette-files with the New, Open…, Save and Save as… 
buttons. To change the number of classes of the palette, change the number in the Palette size 
edit box and then press the Tab key on your keyboard. Clicking on the Reverse palette button 
will swap the colours in the palette. 

Clicking the colour box in the palette will open the Class characteristics dialog window and 
enables you to specify the colour of the class. The palette blend section allows for some 
automation in the selection of colours. You can select a range of classes with the Lower and 
Upper index and change the colours of the classes between the two indices to a blend of the 
colours of the indexed classes. This way, you can easily make a smooth palette that blends from 
one colour to the next. 

Graphs 

This graph editor is used extensively in WAIKATO SDSS to define two-dimensional relations: 
time series and distance decay functions. It has two main parts: to the left is a graphical 
representation of the two-dimensional relation and to the right a list box with the x/y value pairs 
defining the relation. 

 
The graph can be edited in the graphical part only. Changes made are immediately visible in 
both parts. 
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A relation is entered or changed by entering points in the graphical representation. Move the 
cursor to the abscissa position for which you want to enter a new (ordinate) value. Double click 
with the left mouse pointer to add a point to the relation. As a result a little circle will be drawn 
and line segments will connect the new point to the nearest points left and right in the graph 
created thus far. To reposition a point, click it with the left mouse pointer and move it to its new 
position with the left mouse button held down. Or, in order to position it to a particular x-y 
location, click it with the right mouse button and enter the abscissa (x) and ordinate (y) values in 
the Edit point dialog window which opens. To remove a point from the relation, double-click it 
with the left mouse button. 

The ranges of the x- and y-axis can be changed by clicking the Options button. The Options 
dialog window will open in which you can enter the lower and the upper bounds of the x- and y-
axis. 

 
When the Grid check box is checked, a grid is drawn in the graph window. 

Single Value and time 

Clicking the mouse over the Text box, the user can enter or edit a single numerical value 
directly. 

 

 
You can use one example of how to use the date and time editor by going to Drivers-
>Parameters->Land use->Land use parameters. Clicking the mouse over the Text box of the 

Text box 
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date and time editor, the user can also enter or edit a date and time for map file reloading at the 
specified date and time (see section Map file). 

 

Tables 

The table editor enables the user to enter a series of numerical values. You can use copy and 
paste functions by pressing the keyboard shortcuts Ctrl+c and Ctrl+v to edit the selected 
numerical values between the table in WAIKATO SDSS and Excel sheets.  

 

Map file 

The map file editor lets a user add or update maps at the specific date and time.  

 
Before loading a map file, the status of the file is “No file selected”. Click the mouse on the 
Browse button in the table, the Select dialog window or the Open dialog window for map files 
will open. Look for files with an .asc, .img, or .rst extension. Once the name of the file appears 
in the Select dialog window or the Open dialog window select it and press the Open button or 
double click the file icon.  

No file selected 
Browse button 
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Once the file has been loaded, the directory of this map file is shown in the file status cell.  

2.2.3 Running a simulation 

Once the Main window and Land use map window have been opened, the program has read the 
default values for all the parameters as well as the initial values for all the state variables of the 
model. The program is ready to run a simulation. You can run a simulation with the simulation 
control buttons in the Toolbar or with the commands in the Simulation menu. 

 

 
The most right box displays the Simulation clock, which indicates the progress of the simulation: 
it displays the year until which the simulation has run. The initial year is 2004. 

Init 

To initialise the simulation, use the Init command in the Simulation menu. After the model has 
been initialised, all the variables will display the correct initial condition (values) of the model. 
If the Step or Run command is clicked the simulation will be automatically initialised if this has 
not been done manually. 

The Init command can also be used to have the model perform a step without advancing the 
simulation clock. This is especially handy to test the immediate effects of a newly entered (set 
of) parameter(s) before running the model. 

Simulation clock Tool bar 



 

 28 

Step 

To verify that the program is ready to run, use the Init command in the Simulation menu or press 
the Step button in the Toolbar. Once pressed, WAIKATO SDSS will go through a number of 
essential phases, such as the initialisation and testing of its inputs, which are of no direct interest 
to the user before it will make one simulation time step. This will take a while. You will notice 
that the action is finished when the simulation time changes from 2000 to 2001 and the land use 
map in the Land use map window is updated. 

If the Step command is selected the simulation will be automatically initialised if this has not 
been done manually. 

Run 

To perform the simulations for the whole simulation period, use the Run command in the 
Simulation menu or press the Run button in the Toolbar. The simulation will start running till the 
next pause tab has been reached and the progress can be followed as the Land use map window 
and the simulation progress clock are updated on a yearly basis. 

Unless other pause tabs have been set by means of the Pauses command (see section Pauses) in 
the Simulation menu, the simulation will halt at the end of the simulation period. If the Run 
command is selected the simulation will be automatically initialised if this has not been done 
manually. 

Once the simulation is running, the user can halt it by selecting the Stop command from the 
Simulation menu or by pressing the Stop button from the Toolbar. 

Stop 

The simulation can be paused by pressing the Stop button in the Toolbar or using the Stop 
button in the Simulation menu. When the simulation is paused, it will finish the calculations for 
the current year and then pause. The simulation will continue when the user selects the Step or 
Run command from the Simulation menu or when the Step or Run button from the Toolbar is 
pressed. 

You can also pause the simulation at predefined instances, by using the Pauses command (see 
section Pauses) in the Simulation menu. 

Reset 

You can switch the simulation clock back to the initial year of the simulation or undo the 
simulation step by pressing the Reset button in the Toolbar or using the Reset button in the 
Simulation menu. The input information of the model is not affected by resetting the simulation. 
Hence, corrections made to parameters and maps, such as suitability maps, zoning maps, 
network maps, are not affected. However, after resetting the simulation, the state variables, 
including the dynamic maps are calculated again for the initial year and on the basis of the 
available input information. 

Since we have not changed parameter values remaining unchanged is of no importance now, but 
it will be an important issue once you will be changing parameter settings while running and 
testing different scenarios and planning options with the system. 

Pauses 

To set the pauses of the simulation, use the Pauses… command in the Simulation menu. When 
Pauses… is selected, the Pause Settings dialog window opens. Use the Run command in the 
Simulation menu or press the Run button in the Toolbar to advance the simulation till the next 
pause is reached. 
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Display format 

In the Display format pane of the Pause settings window, you can define the display format of 
pause instants by clicking the radio button in front of the format that you want to display. When 
you switch the format, the list of pauses is displayed according to the format that you selected.  

Be aware that the Display format that you defined in the Pause settings dialog window will be 
used for the overall time in the system, such as the time format in the Log maps in the Options 
menu and Simulation clock on the Toolbar. 

 
Add 

You can add a new pause by pressing Add on the right hand side of the Pause Settings dialog 
window. Enter the year in which you want to halt the simulation in the Time text box and then 
press OK. The pause at this year will be added to the Pauses list. 

 
Generate 

You can predefine instances by using the Generate command. The generate pauses dialog 
window opens when you press the Generate button of the Pause settings window. You can 
enter the interval start time, the interval end time and the interval step length of the generate 
pauses window and press OK button. The pauses are generated and displayed on the Pauses list 
of the Pause Settings dialog window. 
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Remove 

You can remove a pause by selecting the pause year that you want to remove and pressing 
Remove button on the right hand side of the Pause settings window. 

2.2.4 Saving simulation results 

Working with a simulation model is to a large extent an iterative process. The user explores 
different combinations of interventions and alternatives to interactively learn which are likely to 
satisfy the preset criteria. These explorative exercises require a capability of storing simulation 
results in an efficient manner. 

The .xml file contains parameters and references to all the maps that are required to run a model 
and the output maps of the model for the simulated year. Saving simulation results includes 
saving the parameters and maps of the simulation. They are saved in different ways. 

Saving parameters 

• Before you save the simulation, the changes of parameters that you made in your model 
are only processed after you press Reset, Init, Step or Run.  

• If you try to save a simulation without doing this, a message will appear reminding you. 

Saving maps  

• You can save the output maps for the current simulated year by going to the Save 
simulation or Save simulation as option in the File menu. 

• You can specify the directory of maps that you want to save in the opened Set external 
file names dialog window. 

Beware that you should press Reset button if you want to save (or save as) the simulation in the 
start year; otherwise, the simulation for the current simulated year will be saved. 

Save simulation 

The Save simulation command from the File menu allows you to store simulation results to the 
current simulation file in sophisticated ways. More in particular, it enables you to efficiently 
manage the individual files that constitute a single simulation. A single simulation run can 
generate anywhere from 1 to dozens of files per simulation step. Hence, if all these files would 
be saved, storing a large number of simulation runs would require much storage space on your 
hard disk. 
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When you select Save simulation from the File menu, the Set external file names dialog window 
opens. The Set external file names dialog window displays an overview of all the data files that 
are used in the current simulation:  their respective names and paths.  

 
If you are a relatively new user of WAIKATO SDSS, press the Save button to complete saving 
the simulation and skip the remainder of this section. If however you are more experienced with 
the system, this dialog window will help you to change the composition of your simulation file 
before saving it.  

• Keeping the same directories for all data files: If you press the Save button in the Set 
external file names dialog window, all the data files on the list will be saved in the 
default directories which are configured in the current simulation file.  

• Changing the directory or the file name of each data file: The system allows you to 
specify the directory where you want to save each data file by left clicking on the path 
name in the File Name text box. Once it is selected and marked blue, you can type any 
path or file name you want. The system allows you to change the format of data file by 
clicking  and selecting the appropriate data type from the drop down list. 

• No file: The data file marked as “-” on the File name list indicates this file is not used or 
not required for the current simulation. You can always use the Reset to undo the 
changes in the table.  

Once you press the Save button of the Set external file names dialog window, the current 
simulation file will be overwritten, and the original information will be lost. Overwriting files 
can be avoided simply by choosing another file name than the current one (see section Save 
simulation as). 

Save simulation as 

The Save simulation as … command from the File menu allows you to store simulations with to 
another file name. When you select Save simulation as …, the Save simulation file dialog 
window opens, requesting you to enter the name of the file.  
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If the name of the current simulation file is entered, the system asks you whether you want to 
replace the existing file. If you press Yes button of the Save dialog window, the Set external file 
names dialog window opens. You can find the description of the Set external file names dialog 
window in section Save simulation.  

The Save simulation as… command and the Save simulation command will only save the model 
for the current year in the simulation – that is, current values of state variables and parameters. 
It will not store intermediate results. To save these, you should make use of the Write to Excel… 
command, the Log maps… command and the Animate maps… commands from the Options 
menu. You will find more information on these in section Write to Excel, section Log maps and 
section Animate maps, respectively. 

Write to Excel 

Select the Write to Excel… from Options to establish (or interrupt) a link between WAIKATO 
SDSS and a Microsoft Excel Workbook. A new window appears as shown below. This link is a 
DDE (Dynamic Data Exchange) link. Via this link WAIKATO SDSS is sending model output to 
the Workbook while the simulation is advancing.  

 
The data transferred to the Excel workbook shows results for the national and the regional level, 
as well as summarized information for the land use model.  
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Defining Excel sheet name 

The list of predefined output options are displayed per model block from which they origin in 
the Model block name column on the upper pane of the Write to Excel settings window. The 
system will only make links for the model blocks which have been configured in the column of 
Excel sheet name. You can enter a name on the list by left clicking the cell next to this block. 
The names that you add in the Write to Excel settings window will be displayed as the names of 
the sheets in Excel. 

 
Defining writing moments 

While a simulation is advancing, the system only writes model output for the moments that are 
determined in the Writing moments pane on the low left part of the Write to Excel settings 
window. You can adjust the list of writing moments by using the Add… button, the Generate… 
button, the Delete button and the Reset button. 

• You can add a single moment by pressing the Add… command. The Add write moment 
dialog window opens and you can enter the moment for which you want to display the 
model outputs in the Excel workbook. Then press OK. The write moment at this year 
will be displayed on the Writing moments list immediately. 

 
• You can define log moments at regular intervals by pressing Generate… command. The 

Generate log moments dialog window now opens where you can enter the interval start 
time, the interval end time and the interval step length. Press OK button afterwards. The 
pauses are generated and displayed on the Writing moments list immediately. 
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• You can easily delete one or several writing moments by selecting the moments that 

you want to remove and pressing Delete. 
• If you are not satisfied the moments that you just set up, you can undo the configuration 

of the writing moments by pressing the Reset button. This action will reset all writing 
moments to the value they had when you last opened the Write to Excel settings 
window. 

Starting writing 

To finalise the link between WAIKATO SDSS and Excel workbook, press the Start writing 
button on the right low pane of the Write to Excel settings window. The Write to Excel settings 
window closes automatically. A link between WAIKATO SDSS and Excel workbook is 
established after this action, although you cannot see this directly on your screen.  

 
While this function is activated, Write to Excel on the Options menu is preceded with a tick 
mark. Now you can run the simulation with the link to the Excel workbook.  

 
Saving settings  

The system allows the user to change settings for write to Excel while the simulation is running. 
To do so, click the marked Write to Excel option in the Options menu. The Write to Excel 
settings window opens again. Now the Save settings, and the Open Excel workbook buttons are 
available on the right low pane of the window. 

You can only change the settings of in the Writing moments but you cannot change settings in 
the Excel sheet name pane that are greyed-out.  
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It is very import to press the Save settings button to finish the adjustments while keeping the 
system writing model output to the Excel workbook. Only the moments, which are later than the 
current simulation time, will be written to the Excel workbook. The function of Write to Excel in 
the Options menu is still preceded with a tick mark.  

If you press the Open Excel workbook button, the function of Write to Excel will be switched 
off. You can always check whether the link to Excel is activated from the tick mark Write to 
Excel in the Options menu. 

Opening Excel workbook 

To stop writing to Excel and view the Excel workbook, press the Open Excel workbook button. 
The workbook opens immediately, showing the worksheets with the names that you defined. 
You can use it now for further analysis of the simulation data. 

  
Note that in order to establish a successful link, it is required that Excel is installed on your 
machine. If WAIKATO SDSS cannot find Excel, the menu option will be greyed out.  
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Log maps 

Use the Log maps… command in the Options menu to store all the maps produced by the 
system in the form of .rst files. You can analyse these logged maps files with the MAP 
COMPARISON KIT – see section 2.2.5 Analysing results. When this command is selected the 
Log settings dialog window opens. 

 
Selecting maps 

In the Selected maps pane, a tree of maps is available, which is organized by the type of 
information on the map. You can expand or collapse the braches of map tree by moving the 
mouse over the name of group and left click. In this tree, you can indicate which maps you want 
to store. To this effect, click on the check box just left of the name of the map of your choice. 
Maps are selected for logging if the check box is checked with a green mark. 

Changing path of log maps 

The program automatically sets the path for files where the maps are stored, as shown in the Log 
folder pane. But it is import to specify and group the path for log files relative to the simulation 
that you are running. Otherwise, previously logged maps will be overwritten. 

To modify this path, click the Browse button on the right side of the text box and the Browse for 
folder window opens. You can select a folder by moving the mouse over the folder where you 
want to store the log files and click. you can also specify the location in a sub folder under the 
selected folder by pressing the Make new folder button. Press the OK button to finish the action 
of changing the path for a log maps. 
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Editing log moments 

In the Log moments pane on the low left part of the Log settings window, you can specify 
moments for which maps will be logged.You can make a list of logging moments by using the 
Add…button, the Generate… button, the Delete button and the Reset button of the Log 
moments pane. This works similarly to Defining writing moments in the write to Excel.  

The system allows you to change the display format on the Add write moment and Generate log 
moments dialog windows by using the Pauses…command in the Simulation menu (see section 
Pauses). You can change the settings in the Selected maps pane and the settings of in the Log 
moments pane while the simulation is still advancing.  

Turning logging on 

To active the logging functions, you have to press the Turn logging on button on the right low 
pane of the Log settings dialog window. The selected maps in the tree of maps will be stored in 
the path you specified. The function of Log maps in the Options menu is proceeded with a 
mark. 

 
 

Saving settings 

Press the Save settings button to finish any adjustments made in the log settings. Only the maps 
for the moments, which are later than the current simulation time when pressing save settings, 
will be logged. The function of Log maps in the Options menu is still with a tick mark when it is 
activated.  

Turning logging off 

To stop the logging functions, press the Turn logging off button on the right low pane of the Log 
settings dialog window. The function of Log maps in the Options menu is displayed without a 
mark. 
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Animate maps 

It is also possible to make movies of dynamic maps during a simulation and store them for later 
use. To that effect us the Animate maps… command from the Options menu. When this 
command is selected the Animation settings dialog window opens. Animations are stored in the 
form of .gif animations. 

 

 
Selecting maps 

In the Maps to animate pane, the tree of maps is shown, which is organized by different groups. 
You can expand or collapse the branches of map tree by moving the mouse over the name of 
group and left click. In this tree, you can indicate which maps you want to animate. To this 
effect, click on the check box just left of the name of the map of your choice. The map is 
selected for animating if the check box is checked with a green mark. 

Changing path of animation maps 

The program automatically sets the path and name of the file where the animations are stored in 
the Animation directory text field. You can change the filename and location where the 
information will be stored by pressing the Browse button on the right hand side.  

When the animation function is activated in the WAIKATO SDSS, this is indicated with a mark 
in front of this option in the Options menu. If no map is selected in the Animation settings dialog 
window, no animations will be generated during the simulation. 
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You can view the animations in most, if not all, recent Internet browsers as well as some 
graphics packages equipped with an animation facility. 

2.2.5 Analysing results 

The system can create a link between the WAIKATO SDSS and the MAP COMPARISON KIT to 
analyse results. To activate the MAP COMPARISON KIT from the Main window, click the 
Analysis tab from the Main window and press Map Comparison Kit. 

 
The Map Comparison Kit comes with its own dedicated manual which is delivered as an 
integral part of the WAIKATO SDSS package. It explains the use of the MAP COMPARISON KIT 
(MCK). It describes in detail how you can analyse and compare the .log files generated by 
WAIKATO SDSS in an interactive manner. All .log files generated by WAIKATO SDSS are 
compatible and can be read into the MAP COMPARISON KIT in a straightforward manner. 

One example about how to use Map Comparison Kit to compare scenarios for Policy user is 
given in section 2.3.6 Analysing results. 
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2.3 Policy interface 

The user interface of the WAIKATO SDSS system provides access for two types of users: the 
policy user who carries out impact assessment studies related to the impact of certain policies 
under a range of external conditions and the modeller or the scientific user, who is responsible 
for the underlying (scientific) information of the system and needs to adapt underlying data and 
parameters when more knowledge becomes available over time. 

The Main window provides access for both types of users. The structure of the Main window is 
available in section Map window. Here we will first explain how the policy user can use the 
system and then how the modeller can access the models.  

The policy user finds access to all information relevant for analysing the impact of policies and 
external factors on the left hand side of the Main window. Information is organised in such a 
way that the user can carry out a structured analysis. It follows the steps Drivers, Scenarios, 
Indicators and Analysis, each of which is explained in more detail below.  

 

2.3.1 Overview of the policy interface 

This section gives a brief overview of the different steps a user can take to carry out a policy 
impact assessment with WAIKATO SDSS. In the following sections each step will be explained 
in detail.  

When clicking on the Drivers button on the left hand side of the system you get access to the 
driver section and the different types of drivers become visible: External factors, Policy 
measures and Parameters. The first two are part of the policy analysis functionality of the 
system; the latter is the way scientists or modellers can get more detailed access to the 
underlying models, their data and their parameters. Clicking on each of the driver type icons 
opens the settings for this driver or set of drivers on the right. 
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Step 1: Setting up the drivers 

In the first part of the analysis, Drivers can be introduced and/or adapted. Drivers are 
incorporated in the system are organised in two groups: External factors and Policy measures. 
When you click on one of these, you get access to the underlying information. This is also the 
entry point for adapting drivers and entering new data. 

The result of this step is a set of sub-scenarios for each of the drivers. When developing a sub-
scenario the user can build on existing sub-scenarios. For example, for the driver External 
factors, a baseline sub-scenario is incorporated in the system that includes all the baseline 
information from the Economic model. If a user wants to build on this scenario he or she simply 
loads the baseline scenario, makes the required changes and saves it under a different name. 

Since the different drivers are organised per discipline it is also possible that different users 
(with different expertise) prepare sub-scenarios for different drivers. The sub-scenarios is not 
yet included in the current version of WAIKATO SDSS. 

Drivers that are including in WAIKATO SDSS are the following:  

• External factors 
• Economic drivers: international exports, interregional exports, gross fixed capital 

formation and changes in inventories. 
• Population drivers: fertility rate, migration rate and mortality rate 

• Policy measures 
• Economic options: rates of change in eco-efficiency and rates of change in labour 

force productivity 
• Zoning measures 
• Infrastructure 

Steps required to view or change driver settings are described in section 2.3.2 Setting up the 
drivers. 

Step 2: Creating integrated scenarios 

In the second step, integrated master scenarios can be assembled from a selection of the sub-
scenarios constructed in step 1. For each of the drivers you need to select the desired sub-
scenario. Drivers that are incorporated in the current version of WAIKATO SDSS are: 
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• Policy measures (Zoning, Infrastructure) 
• Population 
• Economy 

When clicking on the Scenarios button in the main window you gain access to that part of the 
interface where you can construct your integrated scenarios or upload a pre-defined scenario. 

Steps required to create integrated scenarios are described in section 2.3.3 Creating integrated 
scenarios. 

The part is not yet included in the current version of WAIKATO SDSS. 

Step 3: Running the simulation 

Before running any simulation you can decide which results you would like to save to disk 
while the simulation is running. WAIKATO SDSS has three ways of saving results: 

• Link to Excel (for all results at the local level, district level, region level and the 
NZ&World level): When this option is enabled all selected model output will be 
directly written to Excel and can be used for analyses and post-processing after the 
simulation is finished. 

• Log (for all map results): When this option is enabled all selected model output will be 
saved as .rst maps that can be opened in the MAP COMPARISON KIT (part of the 
WAIKATO SDSS package) or common GIS packages, for further analysis after the 
simulation has run. 

• Animations (for all map results): When this option is enabled all selected model output 
will be saved as little movies in Animated GIF format that can be opened in a viewer, 
but can also be readily incorporated in presentations. 

For details about running a scenarios and saving simulation results, please go to section 2.3.4: 
Running a simulation.  

Step 4: Visualising indicators 

After running a simulation, the WAIKATO SDSS offers several options to analyse results. The 
first option is to visualise the indicators that are being calculated by the system. The indicators 
are organised in three groups: 

• Economic indicators 
• Environmental indicators 
• Social indicators 

On a yearly basis each of these indicators is calculated. Depending on the type of indicator, it is 
calculated at one of the spatial levels (NZ & World, Region, District or Local) or at several 
spatial levels. When clicking on the Indicators button in the main window you gain access to the 
indicators. Steps to take in visualising indicators are described in section 2.3.5: Visualising 
indicators. 

Step 5: Analysing results 

The final step of the impact assessment study is to analyse results within a scenario (e.g. the 
temporal evolution of a scenario) or to compare a set of scenarios. In step 3 of the assessment 
you have selected what type of information you would like save for analysis, in this step you 
carry out the analysis. The Excel files that have been created can be analysed with Excel; the 
animations can be shown in a viewer; and the maps that have been saved in log-files that can be 
opened in the MAP COMPARISON KIT, which can be opened when going to the Analysis part of 
the Main Window.  
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2.3.2 Setting up the drivers 

In this section you will become familiar with the different drivers in the system and learn how to 
enter and change information related to these drivers. There are 3 sections under the Drivers tab: 
External factors, Policy measures and Parameters. Among them, the Parameters section is 
relevant only to a modeller. The detailed description about the Parameters section will be found 
in the next section 2.4 Modeller interface. 

When you start the system with the simulation file Land use and Economics.xml all baseline 
data is loaded into the system. In the following sections you will learn how to view and change 
the baseline information step by step for each of the drivers in the system. Creating new sub-
scenarios for the individual drivers can be done in two ways: 

• By building on the baseline information. In this case adaptations are being made to the 
data that comes up when you open Land use and Economics.xml. 

• By building on information in other sub-scenarios. In this case you first have to load a 
sub-scenario for a specific driver and subsequently you can make your adaptations to 
this sub-scenario.  

Both options will be shown in the following sections. 

External factors 

 
When you click on the External factors button on the left hand side of the Main window you will 
see that the right hand side of this window changes in such a way that you get access to the 
External factors that are included in the current version of WAIKATO SDSS: 

• Economy 
• Population 
• Climate1 

                                                      

1 In WAIKATO SDSS, Projected changes to 2050 of New Zealand annual rainfall, temperature 
and potential evapotranspiration (PET) corresponding to three Intergovernmental Panel on 
Climate Change (IPCC) global greenhouses gases emissions scenarios (low, mid-range, and 
high) have been produced.  The projections are based on the average of output from 12 Global 
Climate Models (GCMs) compiled for the IPCCs Fourth Assessment Report (AR4).  GCM 
output is statistically downscaled to a 0.05° lat/long (approximately 5km) spatial resolution for 
all of New Zealand. Since the user can only select one of those scenarios, but not change the 
contents of the individual scenarios, the scenarios are not available in the Drivers part of the 
Main window. They can however be selected in the Scenarios part of the main window. 
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In the top part of the Economy part, you see a drop down list from which you can select the 
sector that you are interested in.  

When you have the External factors in front of you, you can carry out the following actions: 

• View historic data 
• View scenario data (future assumptions) 
• Adapt historic and scenario data 
• Load an existing scenario (not yet included in the current version) 
• Make changes to an existing scenario and save its results (not yet included in the current 

version) 

Since the steps are very similar for all external factors we take Economy as an example to 
explain how you can work with the external factors. 

Viewing historic data and scenario data 

• Go to the Driver section of the Main window. 
• Click on the External factors icon. 
• Go to the Economy part. 
• Select from the drop down list the sector that you are interested in. 
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There are four economic variables for each sector: International exports, Interregional exports, 
Gross fixed capital formation and Changes in inventories. You can view and edit the values of 
these variables for each sector. You can click on the graph icon  behind International exports 
to have a graph pop up. This graph shows International exports in mln NZ$ (2004) on the y-axis 
and the year is on the x-axis. You can press Cancel to go back to the Main window.  

Adapting values for external factors 

• Go to the Driver section of the Main window. 
• Click on the External factors icon and choose from the drop down list in the economy 

pane the sector Horticulture and fruit growing. 
• Click on the graph icon behind International exports to open the graph that shows you 

the international exports from 2004 to 2031. 

There are several ways to enter new data points in the graph. The first way is to drag the bubbles 
in the graph to their desired value. You can also enter the precise values by clicking on a bubble 
with your right mouse button or by clicking on a value in the list on the right hand side of the 
graph. More bullets can be added by double clicking with the mouse in the graph and bubble 
can be deleted by double clicking again on a bubble.  

• Remove all points (bubbles) for which you do not want to provide scenario information. 
• Note: Changing the first bubble (2000) does not have an impact on your simulation. 

This data is fixed to ensure consistency throughout all layers. Moreover, it is not 
possible to remove the final bubble. 

• Add any bubbles for years you would like to provide scenario information for. 
• Drag the bubble(s) of the year(s) you would like to change to the desired location or 

click with the right mouse button on the bubble to enter the exact values for the year 
and the international exports.  

• Press the OK button to save your results and close the graph. 

You have now adapted the international exports for the horticulture and fruit growing sector. 
After you have created a new sub-scenario for a driver you can save this sub-scenario By 
pressing the Save button on the bottom of the Main window. 

The system now allows you to choose between updating the present scenario or creating a new 
scenario. Note that you are not able to update sub-scenarios that are part of the 5 predefined 
scenarios incorporated in WAIKATO SDSS. In case you are working with one of those sub-
scenarios the system will automatically inform you that you can only save the sub-scenario 
under a new name. 

To save the sub-scenario you have just created under a new name select New and Press OK. 
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A dialog window opens in which you can enter the name of the scenario and the short 
description. 

• Give your scenario a new name in the text box of Scenario name and give a description 
of the scenario in the text box of Notes (something that makes it easy for you to 
remember the scenario by). 

• Press the OK button. 

You have now created a new sub-scenario for international exports for the horticulture and fruit 
growing sector. This sub-scenario can be used in the next step of the policy impact assessment: 
Creating integrated scenarios. 

How to load an existing population scenario?  

• Go to the Driver section of the Main window and click on the External factors icon. 
• Press the Load Scenario button on the bottom left side of the window and subsequently 

selecting your scenario of choice in the dialog window that pops up.  
• Press OK to finalise the steps for loading a new sub-scenario. 

How to make changes to an existing population scenario and save its results?  

• Load an existing scenario as explained in the section: ‘How to load an existing 
population scenario?’. 

• Make your desired changes as explained in the section Adapt values of external factors. 
• Press the Save button on the bottom of the Main window. 

The system now allows you to choose between updating the present scenario (the one you have 
selected to load) or creating a new scenario. To create a new scenario select New and Press OK. 

A dialog window opens in which you can enter the name of the scenario and the short 
description. 

• Give your scenario a new name and give a description of the scenario (something you 
can remember the scenario by). 

• Press OK. 

You have now created a new sub-scenario for an external driver. 

The load scenario and sub-scenario is not yet included in the current version.  

Policy measures 

In the current version of WAIKATO SDSS, the Policy measures section is organised by 
Economy, Zoning and Infrastructure parts.  
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On the right hand side of the Main window you will find an overview of Policy measures:  

 
You can find the Economy part on the top right of the Policy measures window. Here you can 
adapt the values of Rate of change in eco-efficiency and Rate of change in labour force 
productivity for each sector. 

How to adapt values of economy measures? 

• Go to the Driver section of the Main window and click on the Policy measures icon. 
• Go to the Economy part on the top of the Policy measure window and select your sector 

of interest in the drop down list on the top the window. 
• The value shown is the one for the sector you have selected. The units are also provided 

for your information. 
• Now click on the text box behind the Rates of change in eco-efficiency, click on the 

value and subsequently type in a new value. 

You have now changed the value of the Rates of change coefficient for a certain sector.  

 
Besides economic policy measures, the WAIKATO SDSS also incorporates measures for zoning 
regulations and infrastructure. These measures can be found by clicking on the Policy Measures 
button under the Drivers tab on the left hand side of the Main window. In the middle part of the 
window you can enter and display the zoning information, the bottom part is reserved for 
infrastructure. First, you will learn how to change a Zoning Map. Next, the options related to the 
Infrastructure network will be explained. 

Zoning maps represent the policy part of the land use allocation process. Different locations 
have different restrictions for different land use functions. Areas where one land use is allowed, 
like forest reserves for the land use forest, can be restrictive for other land use functions like 
residential or manufacturing. For this reason there is a specific zoning map for each main land 
use functions incorporated in the system: residential, commercial, community service, 
aquaculture, horticulture, biofuel cropping, vegetable cropping, other cropping, dairy farming, 
sheep,beef or deer farming, other agriculture, forestry and manufacturing. The vacant land uses 
such as bare surfaces do not have a specific zoning map since we assume that this land use is 
allowed everywhere, but that there are no areas where it is specifically planned. In general, 
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vacant land uses are the land uses that appear when (agricultural) land is abandoned and also the 
land use that can easily be taken over when population or economic functions expand.   

The zoning maps that you find in WAIKATO SDSS are pre-processed externally to the system 
by a combination and interpretation of different zoning plans. The WAIKATO SDSS system 
comes with a tool, the OVERLAY TOOL, which is specifically designed to create zoning maps 
based on a number of spatial zoning regulations. For more information about the OVERLAY 
TOOL please contact RIKS (info@riks.nl). 

When more information on zoning plans becomes available, this can be incorporated in the 
zoning maps, either by the project team, or by the users themselves. In the following steps you 
will learn how to display and change the zoning maps. 

How to view and edit a zoning map or import a new zoning map? 

• Make sure that you have the Policy measures window in front of you.  
• Go to the Zoning part in the middle of the content pane of Policy measures window. 
• Select the land use function of interest from the dropdown list on the top of the Zoning 

part. 
• Open the Zoning Map for this land use by clicking the Edit map button. 

In the zoning map you will find four different classes: Allowed, Allowed from time 1, allowed 
from time 2 and Prohibited. As you can see from these classes, restrictions can be relieved over 
time.  

To edit the zoning map you have just opened: 

• Open the Zoning Map for the land use of interest by selecting this land use and clicking 
the Edit map button. 

• Enlarge the Zoning Map until you can see the individual cells. 
• Select the Pen or the Flood option to draw the desired zoning plans. You can select the 

category you want to draw by clicking on the radio buttons in front of the legend items. 
• Close the Zoning Map. 

To import a new zoning map: 

• Select in the drop down list the land use for which you would like to import a new 
zoning map.  

• Press the Import map button. A window named Import zoning map will open.  
• Select in this window the file you would like to import and press Open.  

Note: Make sure the map you import has the same size, resolution, projection, x and y 
coordinates and categories as the original zoning map and that it has file extension .rst.  

• Now press Edit map to verify that you have uploaded a new zoning map. 
• Close the Zoning Map. 

How to view and adapt the road network? 

The relationship between land use and transport systems is generally recognized, by planning 
professionals as well as scientists. Also, and importantly, it is recognized that the relationship is 
reciprocal, which means that developments in land use are in part a consequence of the transport 
system and, at the same time, developments in the transport system are by large the effect of 
land use changes.  

The current version of WAIKATO SDSS only incorporates a one-way interaction from transport 
on land use. In future versions a transport model can be incorporated with which the impact of 
land use on transport can also be calculated. 
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In the WAIKATO SDSS infrastructure is represented as a network layer. Accessibility 
coefficients, which describe the importance for certain land uses to be close to elements of the 
infrastructure network, play an important role in the allocation of the land use functions. Policy 
decisions related to the changing accessibility are mainly the construction of roads, railways and 
(possibly) irrigation networks. In this exercise you will learn how to adapt the road network. 

There are two ways to introduce a new road; you can either do it by drawing a line in the user 
interface of WAIKATO SDSS, or by introducing it as a shape file. Since the manually drawn 
segments are often inaccurate and not connected to the rest of the road network, it is advisable 
to introduce the new road in a GIS first. For the sake of the exercise however, we let you draw 
the road in WAIKATO SDSS. 

• Go to the Policy measures section of the Main window.  

Looking at the bottom part of this window you will see the information related to infrastructure. 
We now assume that we want to change the network in 2012. 

 
• Press the Add button on the right hand side of the Infrastructure network dialog window 

and –since we want to introduce a change in 2012– change the date to 2012-Jan-01 
00:00:00 in the dialog window that comes up. Press OK. 

• Select the newly created layer by clicking on the date 2012-Jan-01 00:00:00. 

 
• Press the button View current network and selected changes. First, you will be asked to 

name your new layer. Give it a name of choice and press Save. The network pops up in 
a new window. 
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• Go to Zoom tools on the right hand side of the Map window and select one of the zoom 

options.  
• Go to the map and Zoom in on your region of choice. 

The transport network is not yet included in the current version of WAIKATO SDSS. 

Summary 

In this section you have become familiar with the different drivers in the system. In the next 
section you will learn how to combine these sub-scenarios to create integrated master scenarios. 

2.3.3 Creating integrated scenarios 

In the previous sections you have read how to adapt the different drivers that are incorporated in 
the system. Furthermore, you have learned that each of these drivers can be stored in different 
sub-scenarios. 

 
To create a new scenario you go to the Scenarios tab of the Main window and click on Scenario 
manager. Here you select for each of the drivers that you see on the right hand side a sub-
scenario from the drop down list. Note that new sub-scenarios that you might have created for 
different drivers are also available through the drop down list.  
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• Press the New… button to create a new master scenario 
• Name the master scenario and give it a description and press OK. Your new scenario is 

created! 
• If you want to carry out a simulation with your new scenario, press the Load scenario 

data button on the bottom of the window to load all data of the selected scenario into 
the system. 

Besides creating scenarios, WAIKATO SDSS offers the possibility to delete master or sub-
scenarios. You can delete master scenarios by selecting them and pressing the Delete button 
next to the New… button. You can delete sub-scenarios by selecting them and pressing the red 
cross behind them. Be careful: you can only delete sub-scenarios that are not part of an existing 
master scenario! 

The scenario manager is not yet included in the current version. 

2.3.4 Running a simulation 

A more general description about running simulations is available in section 2.2. In this section 
you will learn how to run a simulation and save its output results while running this simulation. 

Saving output results 

Obviously you cannot investigate all land use changes, as well as other available information, 
while the model is running. Therefore you have several possibilities to export intermediate and 
final results of a simulation: 

• You can take an individual map and export it to analyse it;  
• You can create a log file, that contains a series of maps to be analysed afterwards; 
• You can make an animation that shows you the land use, indicators or other model 

results change over time as a movie; 
• You can create a link to Excel through which all selected model results are directly 

written to Excel.  

Exporting individual maps 

To export a map you need to have the map open in your active Map window. In this window you 
will find the Save grid button in the Tools pane on the right low part of the window (see for 
example the Land use map window). 

Clicking on this button allows you to export the map to the folder you like. There are several 
different file types that you can choose to export maps, from these the Arc ASCII format (*.asc) 
and the IDRISI raster format (*.rst) the most common formats. These file types can be used in 
the MAP COMPARISON KIT (MCK). 

Creating log files 

Log files are actually files that contain a reference to one or several maps. You can decide 
yourself how many maps you want to store for eventual analysis. Log files can also be opened 
in the MCK for further analysis. Log maps can be created by clicking on the option Log 
maps…in the Options menu as described in 2.2.4. When turning on the log functionality, 
remember that maps with a resolution of 200m will use some disk space. 

Creating animations 

Animations are movies that show the spatial developments (e.g. land use, total potential, …) 
over time. They come as a *.gif file which you can play in a web browser or picture viewer. 
Animations can be created by clicking on the option Animate maps… in the Options menu as 
described in 2.2.4. 
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Writing model results to Excel 

Model results can be written to Excel by clicking on the option Write to Excel in the Options 
menu. A Write to Excel settings window pops up that allows you to select what information you 
would like the WAIKATO SDSS system to write to Excel. For a detailed explanation on how to 
write information to Excel, go to section Write to Excel. 

Running the simulation 

Land use change has a spatial as well as a temporal aspect. The spatial aspect is visible in the 
form of a map; the temporal aspect is incorporated in the computation of yearly time steps, 
rather than giving one final situation. Hence the WAIKATO SDSS is a dynamic system.  

To run a simulation, you have the following basic options, which are also described in the table 
in section The Toolbar. You can find these buttons in the Toolbar on the top of your screen, but 
you can also access to them through the Simulation menu): 

• When you press Step, WAIKATO SDSS computes the change for one year.  
• Run lets a simulation run until the final year. By default 2031 is the final year for this 

version of  WAIKATO SDSS. The final year of simulation of the next version will be 
2050. 

• Stop lets the simulation stop at the end of the year it is currently computing. 
• Reset finally resets the simulation to the initial starting year, in this case 2004.  

Besides the basic functionality there are three advanced options to run a simulation: Init, Pauses 
and End year…. These options can be found through the Simulation menu. 

2.3.5 Visualising indicators 

The basic output WAIKATO SDSS produces is information about land use, climate, hydrology, 
water quality, economy, environment and population. However, these numbers and figures are 
not always easy to interpret at first instance. For that reason, WAIKATO SDSS offers the 
opportunity to compute indicators as well. An indicator in this context is a measure to make a 
particular phenomenon perceptible that is not –at least not immediately– detectable.  

Indicators are organised in three groups in the user interface: 

• Social indicators 
• Economic indicators 
• Environmental indicators 

Some of these indicators describe a state (e.g. the land use map) or a condition, others a change 
over time( all indicators with units …/year are indicators showing a change over time. e.g. the 
Annual runoff ). The first set of indicators is already available when starting up the simulation; 
for the second set the simulation needs to take a step first, otherwise the change between two 
years (current year in the simulation and start year of the simulation) cannot be calculated. 
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You can visualise indicators at any point in time (any year) during the simulation. To visualise 
an indicator, take the following steps: 

 Go to the Indicators tab of the Main window. 
 Select the sections on the left hand side on the Main window the type of indicator you 

are interested in: Social, or Economic, Environmental.  

For indicator values calculated for each sector, firstly, you have to select your sector of interest. 
The values of the indicators will be displayed for the selected sector. 

• Visualising time line graphs can be done by going to the Economic sections of the 
Indicators tab. Select on your sector of interest and click on the graph icons  behind 
the names of indicators. 

 
• Visualising choropleth maps can be done by going to the section ?? by clicking the map 

icons under the interested indicators. In general, you need to adjust the color legend to 
show best the choropleth map. See section Legend editor to know how to adjust the 
color legend. The choropleth maps will be available in the next version. 
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• Visualising detailed indicator maps can be done by going to the Environmental sections 
of the Indicators tab and clicking on the Show map button behind the name of the 
indicator. 

 
All spatial indicators can be stored in log maps and as animations. All other indicator results can 
be written to Excel. How to writing information to Excel and how to create log maps and 
animations is described in section 2.3.4 Running a simulation. 

How to compare indicators over time and between scenarios is described in 2.3.6 Analysing 
results. 

The indicators will be described in the next version. 

2.3.6 Analysing results 

Analysing spatial results 

In order to analyse spatial results (maps) more carefully it is often helpful to analyse them pixel 
by pixel or to compare only the land use type you are interested in.   

You have created and saved maps with ten year intervals. Also the scenarios have been run and 
result maps have been saved with the same 10 year intervals.  

To investigate these maps you will use the MAP COMPARISON KIT, abbreviated to MCK. This 
is a tool that contains a multitude of algorithms to compare maps on a pixel by pixel basis.  

Short overview of the MCK 

An overview of the MCK is provided on the next page.  
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The MAP COMPARISON KIT application window consists of the Menu bar, the Toolbar and the 
Work pane. You can simultaneously open different windows for maps and statistics. 
Furthermore, it is possible to keep the Comparison Settings dialog window opened while 
working with the tool: 

• The 1st Map window contains the first map to compare/analyse. To change the contents 
of Toolbar the 1st Map window, choose another map from the drop down list next to the 
1-button on the. If the 1st Map window is not open yet, then you can do so by clicking 
the 1-button. 

• The 2nd Map window contains the second map to compare/analyse. To change the 
contents of the 2nd Map window, choose another map from the combo box next to the 
2-button on the Toolbar. If the 2nd Map window is not yet open, then you can do so by 
clicking the 2-button. 

• The Result map window contains the result map. This map shows the spatial result of 
the last performed map comparison. Depending on the selected comparison method the 
results are presented in a continuous scale or a nominal scale 

• The Result statistics window contains the statistical results of the last performed map 
comparison. 

• The Comparison settings dialog window allows setting and viewing the settings 
belonging to the active comparison method. 

Comparing different years of one scenario 

First we will analyse how the baseline changes over time: 

 Go to the Analysis tab on the left hand side of the Main window. 
 Press the Start Map Comparison Kit button on the right hand side of the window.  

1st Map 

Menu bar Toolbar

2nd Map Result map 

Comparison settings Result statistics 

Work pane 
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Now you can import the logged maps. You will find the logged maps (*.rst) of the baseline 
scenario in the folder of \Simulations\Log by default or in the specific folder that you defined in 
section Log maps. 

 Go to the option Log file… in the Options menu. 
 Select the logged maps that you want to analysis and open them: 2000landuse.rst and 

2030landuse.rst. Automatically the first map that you imported will appear on the map, 
and it shows the land use for 2000. With the drop down lists in the menu bar you can 
select which maps is Map 1 and Map 2 to compare. Select the 2000 land use map as 
Map 1 and the 2030 land use map as Map 2. 

 Choose the Per category in the Comparison algorithm window by clicking the Algorithm 
button on the Toolbar. Now to choose which land use you want to investigate, click the 
Parameters button on the Toolbar and choose Agriculture land use. Now the Result map 
will show you 4 options: in none of the maps, in both maps, only in map 1 and not in 
map 2 and only in map 2 and not in map 1. 

Besides the land use map, you can also analyse other categorical maps in the same way. To do 
this, select another type of categorical map (e.g. detailed land use, abandoned land, or another 
indicator) from the drop down list in the Toolbar and repeat the steps above. 

 If you are interested in looking at the statistical information regarding the changes; go to 
the option Result statistic in the Options menu or press the Statistics button in the 
Toolbar. 

Numerical maps, like the crop area maps that show a percentage of crop area per cell, can be 
compared using measures that can be found under the Compare numerical maps in the 
Comparison Algorithm window. 

Select the crop area maps (or any other numerical map) in the drop down list in the Toolbar. 

 Select Comparison Algorithm – Compare numerical maps – Cell by cell – b-a. 
 Investigate the changes in crop area of different crops over time. 

 
In this exercise you have investigated the actual land use change over one simulation. A more 
interesting investigation would be to compare the results of two different scenarios. This you 
will do next. 

Comparing scenarios 

The simulation that you used until now, the baseline scenario, represents an extrapolation of 
observed historic developments combined with expected future developments. You can say it 
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shows a ‘business as usual’ scenario, it incorporates the processes as they are observed in the 
past and expected for the future. However, the full power of a spatial decision support system 
lies not in this baseline scenario but in investigating different scenarios and analysis of scenarios 
and effects of policy measures. Hence it helps you to answer “what if. . . .” type of questions.  

In this exercise you will compare an alternative scenario with the baseline scenario. For this we 
will again use the MAP COMPARISON KIT.  

First we will import an alternative scenario. 

 To incorporate the logged maps for the alternative scenario, go to the option Log file… 
in the Options menu. Press the Import… button on the right hand side of the Edit Log file 
window and select the *.rst file type and select the logged maps with your scenario of 
choice. 

 Press the OK Button. 

Instead of comparing the start and end map of one simulation you now want to investigate the 
difference between two simulations. We will again do this per category. 

 In the MCK select the baseline result in 2030 as Map 1 and the alternative scenario 
result in 2030 as Map 2.  

 Now you can investigate the categorical maps in more detail. To do so choose the Per 
category in the Comparison algorithm window by clicking the Algorithm button on the 
Toolbar and select the land uses you are interested in.  

Summary 

In the final section of this section you have analysed different results maps of the WAIKATO 
SDSS system. You have compared results from different years within a scenario as well as 
results of a certain year between scenarios. For this you have used the MCK functionality to 
compare categorical maps on a cell by cell basis, to compare numerical maps on a cell by cell 
basis and to show overall statistics. 
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2.4 Modeller interface 

This section deals primarily with the interaction between the Modeller and the software. The 
modeller can have more detailed access to the underlying models of the system diagram to 
update data and parameters and to check the outputs. For details about the model, we refer to the 
accompanying Model description reports of WAIKATO SDSS. 

Only a global overview of the model itself and the features which are not directly linked to the 
model description will be described in this user manual. 

Detailed information about how to update data and parameters through the modeller user 
interface is given per individual model in section 2.4.5. Notice that setting the parameters is part 
of the calibration of the system. Changing the parameter settings can have a major impact on the 
behaviour of the system. If you do not have a good understanding of the individual models, we 
advice you to use the default settings.  

2.4.1 Overview of the system diagram 

The Modeller finds his way through the user interface by going to the Parameters part of the 
Main Window that can be found under Drivers. When clicking on Parameters the system 
diagram of the integrated model becomes visible on the right hand side of the Main window. 

  
The system diagram in the Content pane is the most essential feature of the user interface for 
modeller.  It shows an overview of the structure of the integrated models at the most synthetic 
level and enables access to the details of the model not only at this level but also at lower levels. 
You should learn to use it as a graphical explorer of the model. You can change neither the 
model structure, nor its graphical representation. 

The WAIKATO SDSS system has been implemented by means of the Decision Support System 
Generator GEONAMICA®. GEONAMICA® models consist of Model Building Blocks (MBB’s) 
that contain the code and/or data required to calculate and execute mathematical operations 
varying from a single operation, such as the sum of two numbers, to a complex set of interlinked 
operations (set of mathematical equations). Model Building Blocks are graphically represented 
in the user interface by means of a rectangle with the name of the MBB in it. They are 
connected to one another by means of MBB-Connectors. 

The WAIKATO SDSS MBBs are structured by 4 spatial levels: NZ & World, Region, District 
and Local level. The MBBs incorporated in WAIKATO SDSS are: 

• Climate change scenarios 
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• Hydrology 
• Water quality 
• Economics 
• Demography 
• Dairying 
• Terrestrial biodiversity 
• Land use 
• Spatial indicators 

The representation of the system diagram in the Main window has been created with the help of 
the following basic elements: Model Building Blocks, MBB-Connectors, Connections, and 
MBB-Dialog windows. 

2.4.2 Model Building Blocks (MBB ) 

Model Building Blocks are represented in the system diagrams of the Content pane by means of 
a rectangle with the name of the MBB printed in it. 

 
An active Model Building Block is represented in black. When the mouse moves over such 
block its colours are inverted. Next, if you click in it, a dialog window will be open. This dialog 
window is the user interface of the MBB. It has the double function to receive the user inputs 
and to display the model outputs.  

2.4.3 Connectors and Connections 

Variable and parameter values can be passed from one MBB to the other via Connections, or 
Pipes. MBB’s will dispense variable or parameter values with the rest of the model via Out-
connectors, and will take-in information from other MBB’s via In-connectors. 

The actual data exchange between MBB’s is possible via a Connection (or Pipe) between an 
Out-connector of the issuing block and the In-connector of the receiving block. For each 
variable or parameter value that is exchanged, a connection is displayed in the diagram.  

Symbols Connector 

 

In-Connector 

 

Out-Connector 

2.4.4 Dialog windows 

Each MBB has a Dialog window associated with it. It is the vehicle that permits the interactive 
exchange of information between the user and the Model Building Block: the MBB will 
communicate the results (outputs) of its numerical operations to the user and it will take in the 
data entered (inputs) by the user that are required for the execution of the MBB. It concerns data 
that are internal to the MBB which it does not get from other MBB’s via its In-Connectors. 



 

 60 

Clicking on each of the model names gives you access to the underlying model. A dialog 
window that pops-up is organised in such a way that the (external) input, parameters, and out 
but can be found and adapted on the left  or top part of the window, while the output can be 
found at the right or bottom.  

In WAIKATO SDSS system, the inputs and outputs are organised by map, map file, graph, 
single value and table. The user can find the detailed description about how to edit inputs and 
display outputs by the categories of map, map file, graph, single value and table in 2.2.2.  

Information on all of the underlying models and their data and parameters can be found in the 
Model description reports of the WAIKATO SDSS system. Section 2.4.5 Individual model 
components will describe the user interface of each individual model components. 

2.4.5 Individual model components 

Land use change model 

Land use classes 

Land use is classified in categories, some of which are land uses modelled dynamically and 
some of which remain static in the model. Thus, a distinction is made in the model between 
dynamic and non-dynamic land uses: the dynamic land uses are called Functions or Vacant land 
uses. 

• Vacant states finally are classes that are only changing as a result of other land use 
dynamics. Computationally at least one vacant state is required. Typically abandoned 
land or natural land use types are modelled as vacant state, since they are literally 
vacant for other land uses or the result of the disappearance of other land use functions. 

• Functions are land use classes that are actively modelled, like residential or industry & 
commerce. Functions change dynamically as the result of the local and the regional 
dynamics. 

The non-dynamic land uses are called Features. Features are land use classes that are not 
supposed to change in the simulation, like water bodies or airports. They will not expand, will 
not disappear, and will not change location due to expansion of other land uses or any other 
dynamics in the model. Yet, they influence the dynamics of the Functions, and thus influence 
their location. For example a Function ‘Tourism’ would be influenced (expressed in a spatial 
interaction rule) by the occurrence of the Feature ‘Beach’, due to the simple fact that tourist 
tend to recreate near the sea at the beach. 

In the WAIKATO SDSS application the following land uses are modelled: 

Land use States 
Marine Vacant 
Bare Surfaces Vacant 
Indigenous Vegetation Vacant 
Other Exotic Vegetation Vacant 
Wetland Vacant 
Residential-Lifestyle Blocks Function 
Residential-Low Density Function 
Residential-Medium to High Density Function 
Commercial Function 
Community Services Function 
Aquaculture Function 
Horticulture Function 
Biofuel Cropping Function 
Vegetable Cropping Function 
Other Cropping Function 
Dairy Farming Function 
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Sheep, Beef or Deer Farming Function 
Other Agriculture Function 
Forestry Function 
Manufacturing Function 
Utilities Feature 
Mines and Quarries Feature 
Urban Parks and Recreation Feature 
Fresh Water Feature 
Airports Feature 
Land Outside Study Area Feature 
Marine Outside Study Area Feature 

In WAIKATO SDSS system, the land use demand comes from the Economic model and 
Demography model. 

Overview 

The Land use change model dialog window opens after clicking on the Land use MBB box in 
the system diagram under Drivers->Parameters at the Local level. 

The Land use change model dialog window has been grouped in so-called Vertical Group: Land 
use parameters, Total potential parameters, Neighbourhood parameters, Zoning parameters, 
Suitability parameters and Accessibility parameters.  

 
The use can expand or collapse one of the Vertical Groups by right clicking on it. The system 
allows you to open the Vertical Groups as many as you want. When you right click on one of the 
Vertical Groups, the Context menu opens, which controls how Vertical Groups are arranged on 
the desktop. The list below summarized the Context menu commands. While the command is 
selected, the option of group on the Context menu is preceded with a mark. 

 
Use this button  To: 
Expand all  Expand all the Vertical Groups in the land use model parameters dialog 

window 
Collapse all Close all the Vertical Groups in the land use model parameters dialog 

window 
Land use parameters Open or close the Land use parameters group in the land use model 

parameters dialog window 
Total potential 
parameters 

Open or close the Total potential parameters group in the land use model 
parameters dialog window 

Neighbourhood 
parameters 

Open or close the Neighbourhood parameters group in the land use model 
parameters dialog window 

Vertical Group 
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Use this button  To: 
Zoning parameters Open or close the Zoning parameters group in the land use model parameters 

dialog window 
Suitability 
parameters 

Open or close the Suitability parameters group in the land use model 
parameters dialog window 

Accessibility 
parameters 

Open or close the Accessibility parameters group in the land use model 
parameters dialog window 

Land use parameters 

 
The user is able to view, edit land use maps via the Land use parameters group. The land use 
parameters are structured by Input and Output components which are allocated on the left side 
and right side of the window, respectively.  

The user can view or edit the initial land use map by using the Edit initial land use map button in 
the Input section. A Map window of Initial land use map opens immediately after pressing the 
Edit initial land use map button. Section Map window describes how to view and edit the land 
use map in the Map window.  

Based on the initial land use map for the start year, the system allows the user to add the land 
use changes with specific time by adding the land use change map file. The description about 
how to Add or Delete the map files is available in section Map file.  

Move the mouse over your interest land use changes on the map file list and click on it, this land 
use change will be highlighted, then press the View current land use map and selected changes 
button on the bottom of Input section, a Map window displays which is a overlay of the land use 
map for the current simulation and the selected land use changes. 

The user can view the land use map of the current simulation year by pressing the View land use 
map button in the Output section.  

In the future version of system, the user can view land use summary in your interested region. 
Go to Summary part in the Output section, select the interested region on the dropdown list of 
Region, and then press the View land use summary button on the bottom. The land use 
summary for the specific region opens. In this version of WAIKATO SDSS, the View land use 
summary function is not available. 

Total potential parameters 

The user is able to specify the details of the algorithms used to calculate the total potentials in 
the land use model. The algorithms can be specified separately for the so-called vacant land 
uses (named unconstrained states) and for the function land uses (constrained states). 

The total potential for the vacant and the function states combines the effect of the 
neighbourhood, suitability, zoning and accessibility. The user can find the detailed description 
of interface of their parameters in the following sections. The neighbourhood effect is given a 
stochastic perturbation to simulate the effect of unpredictable occurrences. The extend of this 
perturbation can be controller with the Random coefficient. 
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The model is very sensitive to the total potential algorithms. Hence, changing them may have 
drastic effects on the land use change dynamics. It is better not to tinker with the total 
algorithms unless you have gained a lot of experience with the model. 

 
The system enables the user to enter the Random coefficient in the Input section under the Total 
potential parameters group. As described early, the Random coefficient is a parameter that 
controls the stochastic perturbation performed on the Neighbourhood effect.  The value of this 
parameter must be not less than 0. According to our experience, rang of (0, 2) is the 
recommended value. A value of 0 means no perturbation. 

The system allows you to view the total potential map for you interested vacant or function land 
uses. Select the vacant or function land use on the Land use vacant/function dropdown list, and 
then press the View total potential map button. A Map window of the total potential map for the 
selected land use will open immediately. A potential map displays the transition potential of a 
cell for changing to the land use specified. On the basis of the transition potentials the model 
decides which land use will be allocated to each cell in the next simulation step. Colours in the 
total potential map range from red to green. Cells in red are not attractive for the function. In 
contrast, the green cells are. In the legend of the potential map you will find next to the colour 
symbol two numbers. The figure to the left is the upper limit of the category. The figure to the 
left is the lower limit of this category taken in by the land use function mapped. 

Neighbourhood parameters 

In the Land use model, first and most important are the Neighbourhood influence rules. They 
represent the dynamic element of the Land use model.  

 
The Neighbourhood influence rules are accessible via the Neighbourhood parameters Vertical 
group in the Land use MBB. The Neighbourhood influence parameters window opens after you 
click the Influence rules… button. It is divided by 3 panes: Overview pane, Graph pane and List 
pane. 

The Neighbourhood influence parameters dialog window displays the influence land uses have 
on each other, as used by the land use model. The likeliness that a certain land use will stay in a 
certain cell is, among others, dependant on the land uses that occupy the area around that cell. 
For example, people do not like to live close to an industrial area, so industry will have a 
negative influence on housing that decays as the distance between the two places increases. 
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The influence that a certain land use has on another land use (or itself) is described as a function 
of the distance between two cells (so-called a spline), which is made up of a series of points that 
are connected in a certain manner. An example of such a function is shown in the figure above, 
where the points are connected by linear interpolation. In this graph, the distance runs along the 
horizontal axis and the vertical axis displays the influence that land use A has on land use B. We 
see that, when land use A and B are situated at a distance of 1 (cells), land use B has a positive 
effect on land use A of approximately 5. 

 
We will now describe all the functionality of the Neighbourhood influence parameters dialog 
window, as indicated in the figure above. 

1. Influence table. This displays the influences of each land use on each function land use: 
From… To…. Some of the cells in this table show what the spline that describes the 
corresponding influence looks like. If a spline is flat (0 influence for all distances), it is 
not displayed in the table. Click on a cell in the table to select that influence. The spline 
that describes that influence is displayed on the right side of the dialog. 

2. Auto save changes. If this is checked, the changes that you make to the spline on the 
right side of the dialog will automatically be saved when you select another cell in the 
influence table or when you press the exit button. If the Auto save changes is not 
selected, a window will pop-up and ask you whether or not to save the change that you 
made when you activate another rule.  

Overview pane Graph pane List pane 

1 2 4 3 5 6 7 
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3. Spline graph. This displays the graph of the neighbourhood rule that is currently 

selected in the influence table. The user can find the name of this rule above the graph. 
The graph represents the two-dimensional relation. The x-axis is the Distance by cells, 
and the y-axis is the Value of influence. The points of the spline are displayed as small 
circles, which are connected by a blue line.  
• Points in the graph can be moved by dragging them with the mouse. Clicking on a 

point will, it turns red. Holding Ctrl or Shift and clicking on a point will (de)select 
multiple points. If you hold Ctrl or Shift, you can also make a selection rectangle by 
dragging with you mouse. All points within the selection rectangle will be added to 
the selection when you release the left mouse button. By selecting several points, 
you can move all of them without affecting their mutual relation, with the constraint 
that points cannot be dragged outside the graph area. 

• Right clicking on a point in the graph will open a small dialog that allows you to 
view or enter the coordinates of a point, as shown in the figure below. At the 
bottom of this Edit point dialog window, a note for the range of X values is given. 
You can only enter values for X that fall in this range, otherwise a message reminds 
you again of this range. 

 

 
4. Display options. This opens the Spline display options dialog window as shown in the 

figure below. In this dialog the extent of the graph can be altered.  
• In this version, the system allows user to determine the range of the x- and y-axis 

enter the lower and upper bounds in the text boxes.  
• When the Display grid check box is checked, grids are drawn in the graph window. 

When the Display ticks check box is checked, vertical lines at all possible cell 
distances are drawn in the graph window.  

 
5. Save. This will save the changes you have made to the current spline by pressing the 

Save button which is available only after it is changed.  
6. Reset. This will undo the changes you have made to the current spline, by resetting it to 

its last saved state. The Reset button is available only after a spline is changed. 
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7. Values list. The system provides a table with the coordinate pairs for all discrete cell 
distances on the right hand side of the window.  

The value list is not editable. The relation can be edited in the graph only. Changes made are 
immediately visible in the spline graph and on the value list as well. 

 
Computed from the Neighbourhood influence rules, there are two types of outputs for each 
function land use under the Neighbourhood parameters group: the Inertia map and the 
Neighbourhood effect map. 

 
The inertia map shows the inertia of a function land use. In the Output section, select the 
function land use of your interest from the dropdown list of Land use function. Press the View 
inertia map button, the Map window of the selected function land use opens. Colours in the 
inertia map range from green to red. Cells in green have very high inertia for the specific 
function land use. In contrast, the red cells have not.  

The neighbourhood influence rules describe the effect of one land use on another at each 
distance in the neighbourhood. These influences are accumulated to produce the neighbourhood 
effect in each cell for each land use function. The neighbourhood effect map shows this 
neighbourhood effect for the selected land use function for each cell. Press the View 
neighbourhood effect map button, a Map window of Neighbourhood effect for specific land use 
function opens. The description of Map window is available in the section Map window. 

Zoning parameters 

The zoning or institutional suitability is characterized by one map for each land use function. It 
is a composite measure based planning documents available from the national or regional 
planning authorities and containing among others ecologically valuable and protected natural 
areas, protected cultural landscapes, buffer areas, etc. 
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This dialog under the Zoning parameters group is divided into two parts: a part on the left hand 
side is specific for each zoning map – corresponding to a land use function; and a part that is 
common for all zoning maps.  

In the left hand part, the user can select your interested land use function on the dropdown list. 
As mentioned in section Policy measures, the restrictions can be relieved over time. The 
different classes in zoning maps are: Allowed, Allowed after Start period 1, Allowed after Start 
period 2 and Establishment prohibited. The respective four moments for these classes are: the 
start year of the simulation, the first planning period, and the second planning period and never. 
You can enter the dates and time for the Start period 1 and Start period 2 in the text boxes. 

After you select the land use function of your interest and determine the start of the zoning 
periods, you can import the zoning maps that you have created in the OVERLAY-TOOL. An 
Import zoning map for a “specific land use function” opens where you can select the 
corresponding zoning map.  

 
In a zoning map, for each cell, four zoning states are possible: 

 
• 0: the activity is already present in the cell and / or is allowed from the first planning 

period onwards (green cell); 
• 1: the activity is allowed in the cell from the second planning period onwards (yellow 

cell); 
• 2: the activity is allowed in the cell from the third planning period onwards (orange 

cell); 
• 3: the activity is never allowed in the cell (results in a red cell on the map). 
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You can edit zoning maps by pressing the Edit zoning map button on the left hand side of the 
dialog. A Map window showing the Zoning map for “specific land use function” opens. With the 
Grid tools in this Map window, it is possible to assign specific zoning statuses to individual cells. 

In the right hand part, Zoning anticipations (for all land uses), the system allows you to 
configure the anticipation to changes in the zoning status. You can specify the type of 
anticipation (linear (by default) and S-shape) as well as the size of this effect. A value smaller 
than 1, but larger than 0, will cause a more delayed transition and a value larger than 1 will 
cause an earlier transition. This zoning anticipation acknowledges that before zoning measures 
are released; already the first developments can start. 

Suitability parameters 

 
Suitability is represented in the model by one map for each vacant land use or function land use. 
Values on the suitability map quantify the effect that physical characteristics of the land have on 
the possible future occurrence of land uses. The suitability maps could be created with the help 
of the OVERLAY-TOOL. You can select your interested land use on the dropdown list of Land 
use vacant/function.   

The path of the suitability map file for the first date and time is displayed by default when you 
open the system. The system allows the user to add the suitability map for specific land use with 
specific time by clicking on the Add and Del button. The description about how to add or delete 
the map files is available in section Map file.  

The user can view or edit the suitability map by clicking on the Edit button. With the opened 
Suitability map for “specific land use” Map window, it is possible to change the suitability value 
of individual cells. A higher value indicates a higher suitability. Suitability is displayed in the 
map in colours varying from cyan to red, representing values between 0 (not suitable) and 10 
(perfectly suitable). Before you add the suitability map to the system, you have to ensure that 
the values on the map are integer values. 

The system provides the opportunity to set up the maximum suitability (for all land uses) by 
enter a value of the range of (0, 255) in the text box. This maximum suitability value should be 
the highest value on any suitability map in the WAIKATO SDSS system. In general, if the 
suitability map is created in in OVERLAY-TOOL, it can be used directly in WAIKATO SDSS 
system with a maximum suitability value of 10.  

Accessibility parameters 

The accessibility for each land use function is calculated as a function of the distance to the 
nearest road network. It represents how easy an activity can fulfil its needs for transportation 
from a particular cell. It accounts for: the distance of the cell to the nearest link or node, the 
quality of that link, and the needs for transportation of the particular activity or land use 
function. 
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The system allows you to specify the accessibility parameters used for the calculation of the 
accessibility maps for each land use class by following steps:  

• Select the land use of interest in the dropdown list Land use in the Inputs section.   
• Select the check box in front of Land use is build up if the particular land use in the 

model is contained in the set of urbanised land uses (for example residential land use). 
Select the check box in front of Land use is impassable if the particular land use in the 
model is impassable for other land uses (for example water). 

• Set the implicit accessibility parameters per land use function. The Implicit accessibility 
values range from 0 to 1. Enter the Implicit accessibility parameter for the particular 
land use on a build-up area in the text box after Implicit accessibility for build-up areas. 
Enter the Implicit accessibility parameter for the particular land use on a non build-up 
area in the text box after Implicit accessibility for non-build-up areas. The text boxes of 
Implicit accessibility parameters are only available when one of the land use functions 
in the model is currently selected on the dropdown list. 

• Specify the distance decay and weight parameters per land use function.  The parameter 
table allows you to set the Distance decay for the effect of each Infrastructure type of 
the network on each land use function and it’s Weight. The distance decay is the number 
of cells after which the effect is halved (for positive decays) or doubled (for negative 
decays). The weight determines the relative importance of the infrastructure element for 
the particular land use function. The distance decay can be positive – for example, 
industries like to be near highways – or negative – for example, natural areas are 
preferably not located close to highways. With positive decays this is then the 
maximum value and with negative decays the minimum value. To turn off the 
accessibility effect of a specific land use, you can set its weight to zero.  

In order to visualize the accessibility map of a land use function, it is imperative that the 
simulation has been initialised (see section Init) or the accessibility has been computed (see 
section Step). Use the Step command to compute the new accessibility maps after the network 
has been changed (see section How to view and adapt the road network? 

) or when accessibility parameters have been changed. 

The user can select the land use function of interest from the dropdown list of Land use function 
in the Outputs section. And then press the View accessibility map button to display the 
accessibility map of the specific land use function in the background of the network map. The 
Accessibility for specific land use Map window opens after pressing the View accessibility map 
button. Accessibility is expressed in the range 0 to 1 and is displayed in colours varying from 
red to green: red meaning low accessibility (0) and green meaning high accessibility (1).  
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Economic model 

The Economic model dialog window opens when you click on the Economics MBB box in the 
system diagram under Drivers->Parameters at the Region level. 

 
The Economic model dialog window is structured by 6 tabs: Sector-land use correspondence, 
Consumption, Demand, Land use constraint, Supply and Indicators. 

Scroll bar and slider in the table 

 
The Scroll bar is located the left top part of the dialog window. Four scroll buttons are 
positioned that enable the user to arrange the tabs of the dialog window in an easier way to work 
when the 6 tabs are not all displayed in the Economic model dialog window.  

Use this command To… 
 Move to the left end tab 
 Move tabs to left 
 Move tabs to right 
 Move to the right end tab 

The Economic model dialog window is mainly consists of tables. Some of the headings of the 
tables are not displayed completely. In general, the complete heading could be highlighted by 
moving the mouse pointer over the heading. 

 
The slider can be used to resize the width of columns in the table. Move the mouse pointer to 
the border of two columns that you want to enlarge. Then press the left button of the mouse and 
drag to resize.  
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Sector – land use correspondence 

The Sector – land use correspondence tab is structured by the Parameters section and the 
Output section.  

 
On the top of the Sector – land use correspondence tab, a default Sector to land use 
correspondence table is shown, representing the land use functions of the land use model in the 
rows and the sectors in the columns. Here we specify the extend to which each land use function 
contributes to each sector. The ratio coefficients in the Sector to land use correspondence table 
are used to convert land use demand per sector to land use demand per function. 

You can view or adjust the relation between land use functions and sectors by clicking on the 
corresponding cell in the table, and adjusting the ratio coefficient. Note that the values are 
fractions and that all fraction for one function should add up to exactly 0 or 1. 

Press the Apply button under the Sector to land use correspondence table to confirm the 
modification. One system message window will pop up to remind you to reset the coefficients if 
the values for each function don’t sum to 0 or 1. The system enables you to undo changes in 
coefficients you have made to its last applied state by means of the Reset button. The Apply 
button and Reset button are only active after the change has been made. 
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On the bottom of the Sector – land use correspondence tab, you find the Inverse 
correspondence table representing the land use functions of the land use model in the rows and 
the sectors in the columns, in which the outputs of the extend to which each sector contributes to 
each land use function are shown. The ratio coefficients in the Inverse correspondence table 
will be used to convert land use demand per function at the local level to land use demand per 
sector at the regional level. All sector totals should add up to exactly 0 or 1 again.  

The values of the Inverse correspondence table are updated over time. The user can observe the 
change of the Inverse correspondence table after taking one step simulation if the change of the 
ratio coefficients has been made in the Sector to land use correspondence table.  

Consumption 

 
The Consumption tab is structured by Input, Parameters and Output section. You can review 
and edit the inputs in the table of Input section. This represents the initial household 
consumption per sector for the start year of the simulation.  

In the middle of the Consumption tab, you can review or edit the consumption scalars per age-
sex cohort in the table of the Parameters section. The consumption scalars are used to convert 
the outputs from the Demography model (see section Demography model) to the average person 
equivalent. 

On the bottom of the Consumption tab, it features the output of the current household 
consumption for each sector. The values of the Current household consumption table are 
updated over time. The user can observe the changes in the Current household consumption 
table after taking one step. However, in order to have the consistent parameter values over time, 
it is suggested to reset the simulation before running it. 

Demand 

The Demand tab is split in 3 parts by the sections: Input, Parameters and Output section. 
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In the Input table of the Demand tab, the system allows the user to edit the input of International 
exports, Interregional exports, Gross fixed capital formation and Changes in inventories for a 
specific year.  

 
You can select a specific year from the drop down list Time. The table then shows the input for 
this selected year. You can edit the values per specific year. 

The system enables the user to edit the time list by using the Add time function and the Delete 
time function. The Enter data and time dialog window opens when the Add time button is 
clicked. You can enter the specific time in the text box of the Enter data and time dialog 
window.  

 
After you press OK, the specific time will be displayed immediately on the drop down list Time. 
The system takes the interpolated value for the new added time on the basis of the values for the 
specific years on the drop down list. 
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You can easily delete the table for one specific year by selecting this specific year on the drop 
down list and press the Delete time button next to the Add time button. A message window 
opens. Press the Yes button of the message window to carry out the action of deleting table for 
the selected year. Press the No button of the message window to cancel the action of deleting 
table for the selected year.  

In the middle of the Demand tab, the Inverse Leontief matrix from sector to sector is editable in 
the Parameters section. 

On the bottom of the Demand tab, the output of the Demand module includes the Final demand 
and the Output in mln $ (2004) per sector. The outputs are updated dynamically over the 
simulation period. 

• The Final demand of the Demand tab is calculated on the basis of International exports, 
Interregional exports, Gross fixed capital formation, Changes in inventories and the 
Current household consumption in the Consumption tab. 

• The Output per sector of the Demand tab is the output of all sectors which are caused 
by the Final demand for this specific sector  

Land use constraint 

After the Final demand and Output of the Demand module are calculated, the land use demand 
estimates in the Land use model are taken into account in the Land use constraint tab. This Land 
use constraint tab is split into Parameters section and Output section. 

On the top of the Land use constraint tab, you can view and edit the Eco-efficiency per sector. 
The Eco-efficiency is used to convert the mln $ 2004 per Sector and vice versa. 

 
On the bottom part of the Land use constraint tab, two tables are displayed as the outputs which 
are updated over the simulation period.  

• The Unconstrained land use demand per land use function is calculated on the basis of 
the Output of the Demand tab and the Eco-efficiency. The Unconstrained land use 
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demand for Residential land uses, Aquaculture and Biofuel cropping are zero because 
their land use demand is not calculated in the Economic model. 

• The Constrained land use demand per land use function is the output which is 
constrained by the land use demand from the land use model. 

• The Output corresponding to constraint land use per sector is calculated on the basis of 
the Constrained land use demand and the Eco-efficiency. 

• The Change in output due to land use constraint per sector is the difference between 
Output corresponding to constraint land use and the Output of the Demand tab. 

Supply 

The Supply tab is split in 3 parts: Input, Parameters and Output section. 

 
On the top part of the Supply tab, the system allows the user to view and edit the Ghosh matrix 
from sector to sector. 

On the bottom part of the Supply tab, the user can observed the outputs per sector which are 
updated over the simulation period. 

• The Change in final demand per sector is calculated on the basis of the Change in 
output due to land use constraint of the Land use constraint tab and the Ghosh matrix. 

• The Final demand per sector is calculated on the basis of the Final demand of the 
Demand tab and the Change in final demand. 

• The Output per sector is calculated on the basis of the Final demand and the Inverse 
Leontief matrix of the Demand tab. 

Indicators 

The Indicators tab is structured by the Input, Parameters and Output  sections. 
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On the top of the Indicators tab, it shows the Input table where you can view and edit the initial 
values of the indicators per sector for the start year of the simulation. It should be noted that the 
initial value must be non-negative. 

In the Parameters table you can view and edit the Rate of change in labour force productivity 
and the Rate of change in eco-efficiency per sector. 

On the bottom, you can see the output of indicators per sector. 

• The first column in the Output table is the Current growth factor which is calculated on 
the basis of the Output of the Supply tab for the current year and the one for the 
previous year. 

• The Current value added is calculated on the basis of the Initial growth factor and the 
Initial value added. 

• The Current international imports is calculated on the basis of the Initial growth factor 
and the Initial international imports. 

• The Current employment is calculated on the basis of the Initial growth factor, the 
Initial employment and the Rate of change in labour force productivity. 

• The rest indicators of the Output table are calculated on the basis of their initial values, 
the Initial growth factor and the Rate of change in eco-efficiency. 

Demography model 

The Population data dialog window opens when you click on the Demography MBB box at the 
regional level in the system diagram under Drivers->Parameters. 

In this version, the user can view and edit the population by sex-age cohort for the specific 
years. This is mainly used as input for the Economic model (see section Economic model). 
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You can select a specific year in which you are interested on the drop down list Time. The table 
shows the input for this selected year. You can edit the values per year. 

The system enables you to edit the time list by using the Add time function and the Delete time 
function. Detailed description about how to use these two functions is available in section 
Demand of the Economic model.  

2.5 The WAIKATO SDSS menu system 

This section explains the different functions that are available from the WAIKATO SDSS menu 
system. Some GEONAMICA® functions are not available in WAIKATO SDSS. These are greyed 
out, meaning that they are visible in the menus in a light grey colour, but they do not result in 
further actions when invoked. Consequently, these functions are not described in detail in this 
section. 

Other functions are only accessible when they are relevant. For instance, the Stop command in 
the Simulation menu is only accessible when the simulation is running. 

The menus are treated as they appear in the Menu bar from left to right and per menu from the 
top to the bottom. Most commands in this section have already been described in other sections. 
The user can find more detailed information for these commands through the links in the table.  

2.5.1 The File Menu 

Use the File menu to open and save simulation files, and to exit WAIKATO SDSS. THE 
WAIKATO SDSS saves simulation files with a .xml extension attached to the file name. 

 
Use this command To… Link 
New simulation… Create a new simulation with Waikato SDSS Not available in this version 
Open simulation… Open a simulation file stored on a disk Section Opening a simulation 

file 
Save simulation Save changes to the current simulation file Section Save simulation 
Save simulation as… Save a simulation to a disk Section Save simulation as 
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Use this command To… Link 
Close simulation Close the simulation   
Recent file Display the names and the paths of the 4 most 

recently opened simulation files. If you select 
one of the 4 files, it will be opened 

Not available in this version 

Exit Quit GEONAMICA® 2.1.8 Closing Waikato SDSS 

2.5.2 Simulation menu 

You use the Simulation menu to control the simulation. The commands Step, Run, Stop and 
Reset can also be invoked when pressing the respective buttons from the Toolbar. 

 
Use this command To… Link 
Init Recalculate variables that are affected by 

changes in the user interface. This command 
will not change the simulation time 

Section Init 

Step Advance the simulation with one time step Section Step 
Run Advance the simulation till the next pause tab 

has been reached 
Section Run 

Stop Stop a simulation run Section Stop 
Reset Switch the simulation clock back to the 

Current year of simulation 
Section Reset 

Pauses… Set the pauses of the simulation Section Pauses 
End year… Set the duration of the simulation in years Not available in this version 

2.5.3 Options menu 

Use the Options menu to personalise your workspace or to access WAIKATO SDSS’ additional 
functionalities. 

 
Use this command To… Link 
Legend-files folder… Select the folder in which the legend files that 

WAIKATO SDSS uses are located and stored. 
Legend editor 

Write to Excel Establish or interrupt a link between 
WAIKATO SDSS and the Microsoft Excel 
Workbook 

Section Write to Excel 
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Use this command To… Link 
Log maps Store all maps produced by the system in the 

form of .rst files 
Section Log maps 

Animation maps Store dynamic maps produced by the system 
in the form of .gif animations 

Section Animate maps 

Toolbar View or hide the Toolbar in the WAIKATO 
SDSS applications window 

Section The Toolbar 

Status bar View or hide the Status bar in the WAIKATO 
SDSS applications window 

Section The Status bar 

2.5.4 Window menu 

Use the Window menu to arrange the contents of the screen and to activate one of the opened 
windows. 

 
Use this command To… Link 
Cascade Arrange multiple opened windows in an 

overlapped fashion 
 

Tile horizontal Arrange multiple opened windows one above 
another in a non-overlapped fashion 

 

Tile vertical Arrange multiple opened windows side by 
side in a non-overlapped fashion 

 

Arrange icons Arrange the icons for minimized windows at 
the bottom of the screen 

 

List of Windows Active the selected window on the list of 
opened windows 

 

2.5.5 Help menu 

Use the Help menu to select the type of help that you want WAIKATO SDSS to display on the 
screen. The different commands in this menu will permit to look up information about 
WAIKATO SDSS, its commands, options, and tools. 

 
Use this command To… Link 
Index Get the opening screen of the on-line help file 

of WAIKATO SDSS 
Section Index 

Using Help Get general instructions on how to use the 
Windows Help system 

Section Using Help 

Licence… Open the Licence window Section Licence 
About… Open the About window Section About 
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2.6 Appendix 

Scaling methods 

Since the classification of the values is a partition of the specified range of values, only the 
intermediate class boundaries need to be calculated, that is, the upper bound of a class is equal 
to the lower bound of the next class, assuming an ascending order. To properly define the 
different scales, we will first introduce some notation. 

Let n be the number of classes, N the number of values in the map, min the minimum and max 
the maximum of the total range of the legend; 

Let 
⎩
⎨
⎧
−

>
=

elsemin
min

c
1

0 if0
; 

Let ave, sd denote the statistical average and standard deviation of all values in the map, 
respectively; 

Let lowerbound(i) denote the lower bound of class i, where the class index is zero-based and 
lowerbound(0) = min unless otherwise specified. 

Scaling method Algorithm 
Linear ( ) nminmaxx −=  

( ) 1 allfor ≥⋅+= iximinilowerbound  
Each class has the same width. 

Arithmetic ( ) ( )( )21+⋅−= nnminmaxx  

( ) ( ) 1 allfor 1 ≥⋅+−= ixiilowerboundilowerbound  
This scale is useful for values that grow quadratic. 

Geometric ( ) ( )( ) ncmincmaxx +−+= 1010 loglog10  
( ) ( )( ) 1 allfor 1 ≥−⋅+−= icxcilowerboundilowerbound  

This scale is useful for values that grow exponentially. 
Over-geometric ( ) ( )( ) ( )( )21loglog 101010 +⋅+−+= nncmincmaxx  

( ) ( )( ) 1 allfor 1 ≥−⋅+−= icxcilowerboundilowerbound i  
This is an arithmetic scale of a geometric scale. 

Harmonic ( ) nx cmaxcmin ++ −= 11  

( ) ( ) 1 allfor 1 1 ≥−⋅−= + icxiilowerbound cmin  
This scale is useful for values that follow a factorial function. 

Quantiles An equal amount of values is put in every class, that is, all values in the map 
are stored in a vector data that is sorted in ascending order. Then: 

( ) ( ) ( )( ) 2lowerbound i data i N n data i N n= ⋅ + ⋅⎢ ⎥ ⎡ ⎤⎣ ⎦ ⎢ ⎥ . 

Standardised 
discretisation 

( ) ( )22 −+⋅−= insdaveilowerbound  
Class bounds that exceed the specified range are cut of at the minimum and 
maximum of that range. 
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Scaling method Algorithm 
Method of Bertin ( ) nminavexleft −⋅= 2  

( ) navemaxxright −⋅= 2  

( ) ( )
( ) ( ) ( )

( ) ( ) nixilowerboundilowerbound
n

ixxilowerboundilowerbound

ixilowerboundilowerbound

right

n
rightleft

n
left

<≤+−=

=++−=

≤≤+−=

+

+

−

2
1n

2
1

2
1

 allfor 1
odd  and

for 21

1 allfor 1

 

This scale divides the range into two linear scales around the average. 
Fifth-order 
polynomial 

This method fits a fifth-order polynomial f through the values in the map, using 
an ordinary least squares regression. The class bounds are taken as 

( )( )f data i N n⋅ , where data is a vector of the value in the map sorted in 
ascending order. Note that the lower bound of the first class may be less than 
min, due to the fitting of the polynomial. 

Effectiveness 

Let v(i) be a function of the ith value in the map; 

Let c(i) be the class that contains the ith value of the map; 

Let |c| be the number of values in class c. 

The effectiveness of the classification is estimated by the following formula: 

( ) ( )( ) ( ){ }( )
( ) ( )( )

( )

2
1 1

1

2
1 1

1 1

1 100%

N
N n ci j c j c i

N
N Ni j

MSW v i v j

MST v i v j

effectiveness MSW MST

− = =

− =

= −

= −

= − ⋅

∑ ∑

∑ ∑  

MSW is the mean of the squared deviations within the class, that is, the deviation from the 
class average. MST is the mean of the squared deviations from the mean – the T stands for 
total. Put in words, the effectiveness indicates what portion of the variance in the values is 
accounted for by the classification. To get a fair estimate of the effectiveness, the assumed 
distribution of the values when calculating the deviations need to be taken into account. 
Therefore, the function v() should be the inverse of the function that determines the class 
bounds. Since not all scales can be defined as continuous functions, inverse functions have 
been defined only for the first four scales. Let value(i) denote the value of the ith element of 
the map. 

Scaling method Inverse function 
Linear scale ( ) ( )ivalueiv =  
Arithmetic scale 

( ) ( ) ( )
⎩
⎨
⎧ +>−

=
else

cminivalueminivalueiv
0

 if

 
Geometric scale { }

( ) ( )( ) ( )
⎩
⎨
⎧ −>+

=

−=

else
civaluecivalue

iv

minc

0
1 iflog

0,1max

10

 
Over-geometric 
scale ( ) ( )( ) ( ) ( )

⎩
⎨
⎧ +>+−+

=
else

cminivaluecmincivalueiv
0

 ifloglog 1010
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For the other scaling methods the estimated effectiveness is taken as the maximum of the 
effectiveness, using the function of the linear scale and of the geometric scale. 
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3. The Integrated Model 





 

 87

4. Model building blocks 

TODO 
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5. Indicators 

TODO
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